
KODAK ESP Office 2100 Series
All-in-One Printers

Extended User Guide



Eastman Kodak Company
Rochester, NY 14650

© Eastman Kodak Company, 2011

Kodak, EasyShare, ESP, and Perfect Touch are trademarks of Eastman Kodak Company.

Specifications subject to change without notice.

February 2011



Table of contents
1   Printer Overview
Components......................................................................................................................................................................9
Control panel................................................................................................................................................................... 10
Home Center Software ................................................................................................................................................. 11
Ordering supplies........................................................................................................................................................... 12
Configuring printer settings ........................................................................................................................................ 12
Online Printer Management Tool.............................................................................................................................. 13

Accessing the Online Printer Management Tool ............................................................................................ 14
Using the Online Printer Management Tool to configure your printer’s settings .................................. 14

2  Networking Your Printer
Connecting to a wireless network ............................................................................................................................. 15

Before you connect ................................................................................................................................................. 15
Connecting to a wireless network using the Wi-Fi Setup Wizard.............................................................. 15
Setting up an IP address......................................................................................................................................... 19
Viewing the network configuration.................................................................................................................... 20
Printing the network configuration .................................................................................................................... 20
Changing the printer name .................................................................................................................................. 20
Installing your printer on additional computers on the network................................................................. 21
Connecting to another KODAK All-in-One Printer ........................................................................................ 21

Adding a wireless network connection to a USB-connected computer......................................................... 22
Changing from USB to a wireless connection ................................................................................................. 22

3  Handling Paper
Paper types..................................................................................................................................................................... 24
Paper sizes...................................................................................................................................................................... 24
Envelope sizes................................................................................................................................................................ 25
Loading paper ................................................................................................................................................................ 25

Loading plain paper................................................................................................................................................ 26
Loading photo paper ............................................................................................................................................. 27
Loading envelopes.................................................................................................................................................. 28

Loading originals ........................................................................................................................................................... 29
Using the scanner glass ........................................................................................................................................ 29
Using the Automatic Document Feeder (ADF).............................................................................................. 30

4  Printing 
Printing documents ....................................................................................................................................................... 31

Printing two-sided documents............................................................................................................................. 31
Printing forms ...........................................................................................................................................................33

Printing pictures .............................................................................................................................................................33
Viewing pictures on a memory card or USB-connected device ................................................................. 34
Printing from a memory card or USB-connected device...............................................................................35
www.kodak.com/go/aiosupport  5



Printing from a wireless device ................................................................................................................................. 40
Transferring pictures to a computer......................................................................................................................... 41

Transferring pictures to a computer with WINDOWS OS........................................................................... 41
Transferring pictures to a computer with MAC OS ....................................................................................... 41

5  Copying
Loading originals for copying..................................................................................................................................... 42
Copying a document.................................................................................................................................................... 42

Using the default settings to copy a document.............................................................................................. 42
Adjusting the settings and copying a document............................................................................................ 42
Changing the number of copies of a document ............................................................................................. 44
Enlarging or reducing a document ..................................................................................................................... 44
Darkening or lightening a copy ........................................................................................................................... 44

Copying a photograph................................................................................................................................................. 45
Using the default settings to copy a photograph ........................................................................................... 45
Adjusting the settings and copying a photograph......................................................................................... 45
Changing the number of copies of a photograph........................................................................................... 47
Enlarging or reducing a photograph .................................................................................................................. 47
Darkening or lightening a copy of a photograph ............................................................................................ 47

6  Scanning
Before you begin scanning ......................................................................................................................................... 48

Changing the scan settings for scanning from the printer control panel................................................. 48
Adding a profile and address book for Scan To Email ....................................................................................51
Adding a profile for Scan To Network Folder...................................................................................................53

Loading originals for scanning....................................................................................................................................55
Scanning from the computer ......................................................................................................................................56

Scanning multiple pictures simultaneously......................................................................................................56
Scanning from the control panel................................................................................................................................57
Scanning from the Online Printer Management Tool ..........................................................................................59

7  Faxing
Before you begin faxing............................................................................................................................................... 60

Connecting the printer for faxing ....................................................................................................................... 60
Entering fax sender information ......................................................................................................................... 64
Setting fax options ..................................................................................................................................................65
Working with the phonebook.............................................................................................................................. 68

Preparing a fax for transmission .................................................................................................................................71
Printing a fax cover page ........................................................................................................................................71
Loading originals.......................................................................................................................................................71
Changing resolution and brightness...................................................................................................................72
6 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Sending a fax .................................................................................................................................................................. 72
Using the phonebook to send a fax.................................................................................................................... 72
Using Quick Dial to send a fax .............................................................................................................................73
Using the numeric keypad to send a fax............................................................................................................73
Using the Redial button to send a fax.................................................................................................................73

Receiving a fax ................................................................................................................................................................73
Receiving a fax automatically ...............................................................................................................................73
Receiving a fax manually ...................................................................................................................................... 74

Printing fax reports ....................................................................................................................................................... 74
Fax settings report.................................................................................................................................................. 74
Fax confirmation page........................................................................................................................................... 75
Fax activity log......................................................................................................................................................... 75

Canceling a fax .............................................................................................................................................................. 75

8  Maintaining Your Printer
General care and cleaning .......................................................................................................................................... 76

Cleaning the scanner glass and document backing....................................................................................... 77
Replacing ink cartridges .............................................................................................................................................. 79
Updating the software and printer firmware......................................................................................................... 82

Updating manually if your printer is connected to a computer with WINDOWS OS.......................... 82
Updating manually if your printer is connected to a computer with MAC OS ...................................... 83

Monitoring and adjusting printer performance .................................................................................................... 84
Checking ink levels ................................................................................................................................................. 84
Resetting factory defaults .................................................................................................................................... 84

Replacing the printhead .............................................................................................................................................. 85

9  Troubleshooting
Basic troubleshooting .................................................................................................................................................. 89
Getting help on the Web.............................................................................................................................................. 91
Status lights.................................................................................................................................................................... 92

Power light................................................................................................................................................................ 92
Wi-Fi connectivity LED ......................................................................................................................................... 92
www.kodak.com/go/aiosupport 7



10  Product and Safety Specifications
Features and Specifications ........................................................................................................................................93

Print performance ...................................................................................................................................................93
Photo printing features ..........................................................................................................................................93
Copy document features ...................................................................................................................................... 94
Copy photo features .............................................................................................................................................. 94
Scanning features ................................................................................................................................................... 94
Faxing features and specifications......................................................................................................................95
Paper input tray ......................................................................................................................................................95
Automatic Document Feeder (ADF) for originals ..........................................................................................95
Ink cartridges............................................................................................................................................................95
Connectivity..............................................................................................................................................................95
Software support .................................................................................................................................................... 96
Physical specifications .......................................................................................................................................... 96
Warranty .................................................................................................................................................................. 96
Minimum System requirements..........................................................................................................................97

Safety information...................................................................................................................................................... 100
Regulatory compliance................................................................................................................................................101

FCC statement ........................................................................................................................................................101
Canadian statements ...........................................................................................................................................102
European compliance statement.......................................................................................................................102
German compliance statement .........................................................................................................................102
REACH Article 33 declarations..........................................................................................................................103
Power supply information ...................................................................................................................................103
Waste electrical and electronic equipment labeling....................................................................................103

ENERGY STAR® Qualified.........................................................................................................................................103
Warranty Information ................................................................................................................................................103
Declaration of Conformity.........................................................................................................................................105
8 www.kodak.com/go/aiosupport



1  Printer Overview
This printer lets you print, copy, scan, and fax pictures and documents. 

Components

1 Control panel 10 Scanner glass
2 ADF paper-edge guides 11 Access door
3 Left paper-edge guide 12 Printhead with ink cartridges installed
4 Paper input tray 13 Line in phone port
5 Automatic document feeder (ADF) 14 Ext out phone port
6 Right paper-edge guide 15 USB port (for connecting to computer) 
7 Front USB port (ESP Office 2170 printer 

only)
16 Power cord connection port

8 Memory card slot 17 Output tray extender
9 Scanner lid 18 Output tray
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Printer Overview
Control panel 

Feature Description
1 LCD Displays pictures, messages, and menus
2 Copy mode button Displays the Copy Options menu
3 Fax mode button Lets you enter a phone number for sending a fax, or choose the Fax Options menu
4 Navigation buttons Used to navigate menus and scroll through pictures
5 OK button Selects a menu item, accepts a setting, and continues with the current operation
6 Attention light Blinks when an error occurs
7 Phonebook button Displays the phonebook of fax numbers entered on this printer; lets you enter or edit 

phone numbers
8 Numeric keypad Used to dial a phone number or a Quick Dial number for faxing; to enter information 

and Quick Dial settings into the fax phonebook; to specify a quantity for making 
copies; and to enter information for authenticating access to a network

9 Cancel button Stops the current operation and returns to the menu; clears certain errors to allow 
scanning or sending a fax

10 Start Black button Starts the selected operation in black and white
11 Power button Turns the printer on or off
12 Wi-Fi connectivity LED When lit, signals that the printer is connected to a wireless (Wi-Fi) network; blinks 

when searching for an available Wi-Fi network or when the existing signal is too 
weak to transmit or receive wireless signals

13 Start Color button Starts the selected operation in color, if the source is in color
14 Redial button Dials the last-dialed phone number
15 Auto Answer button Turns the fax auto answer feature on or off; when on, the fax answers all incoming 

calls automatically
16 Auto answer LED Lights when the fax auto answer feature is on
17 Home button Displays the main menu
18 Back button Displays the next higher screen in the menu structure
19 Photo mode button Displays the Print Photo Options menu 
20 Scan mode button Displays the Scan Options menu

1 2 3 4 5 6 7 118 9 10

12131415161718181920
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KODAK ESP Office 2100 Series All-in-One Printer
Home Center Software 
KODAK Home Center Software is installed with your KODAK All-in-One Printer 
Software, unless you choose otherwise. The Home Center icon will appear on your 
desktop. 

On a computer with WINDOWS Operating System (OS), you can use Home Center 
Software to:

• browse, crop, enhance, and edit pictures

• print and scan

• make 3D anaglyphs

• print from video

• send images to or print images from KODAK Gallery

• send images to or print images from FACEBOOK Social Network, FLICKR, 
PHOTOBUCKET, PICASA, or SMILEBOX Photo Management Systems

• configure your printer

• install new network printers

• upgrade to the latest printer software and firmware

• order supplies

• access the KODAK Tips and Projects Center

• access this Extended User Guide

On a computer with MAC OS, you can use Home Center Software to: 

• scan

• configure your printer

• upgrade to the latest printer software and firmware

• order supplies

• see the status of your printer

• access this Extended User Guide
www.kodak.com/go/aiosupport 11



Printer Overview
Ordering supplies
You can order ink cartridges, paper, and accessories online. 

To order supplies, make sure that your computer is connected to the Internet, then:

1. Open Home Center Software.

2. Select Order Supplies (on a computer with WINDOWS OS) or select the Tools 
tab, then click Order Supplies (on a computer with MAC OS). 

3. Select the item(s) you want to buy, then follow the on-screen instructions. 

Configuring printer settings
To set or change basic printer settings: 

1. Press Home.

2. Press  to select Printer Settings, then press OK.

3. Press  to select one of the following settings: 

• Date and Time
– Press OK, then press  to select Year, Month, Day, Hour, or Minute.

– Press or  to change the values; press OK when you are done making 
changes. 

– Press Back to go back to the Printer Settings menu.

• Time to Low Power 

To conserve energy, your printer will enter a low power (sleep) mode after 
being idle for a default delay time of 1 hour. You can increase the delay time to 
low power (in 0.5 hour increments) up to 4 hours. Increasing the delay time 
may result in reduced energy savings.

– Press  to change the time to energy-saving sleep mode (select from 1 to 
4 hours in 0.5 hour increments). 

• Tagged Images Printing (see Printing tagged pictures, page 40)

– Press  to select Off or On.

• Language
– Press OK, press  to select a language, then press OK.

• Country/Region
– Press OK, press  to select a country or region, then press OK.

• Reset All Settings (see Resetting factory defaults, page 84)

NOTE: Resetting factory defaults does not change the date and time, 
language, country/region, or network settings.

• Printer Info
– Press OK to view the Firmware Version number; press OK when you are 

done.

4. Press Back to return to the Main Menu. 
12 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Online Printer Management Tool
Your printer includes a feature that enables you to view the printer status, change 
settings, and capture scans using an Internet browser on any computer that is on the 
same network as your printer, independent of Home Center Software. The Online 
Printer Management Tool also allows you to scan to an email address or to a 
network folder.
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Printer Overview
Accessing the Online Printer Management Tool

If you have a computer with WINDOWS 7 Operating System with Home Center 
Software installed: 

1. Select Start > Control Panel > Devices and Printers.

2. Click the Printer Management icon.

If you have a computer with WINDOWS 7 Operating System without Home Center 
Software installed, or if you have a computer with WINDOWS XP or WINDOWS 
VISTA Operating Systems or any version of MAC OS: 

1. Determine the IP address of your wirelessly connected printer:

a. On your printer control panel, press Home. 

b. Use the down arrow to select Network Settings, then press OK.

c. Use the down arrow to select View Network Configuration, then press OK, or if 
you prefer a printout, select Print Network Configuration, then press OK. If you 
selected Print Network Configuration, a Test Page prints with the IP Address 
and other network information.

d. If you selected View Network Configuration, use the down arrow to locate the 
IP Address, in the format xxx.xxx.xxx.xxx. (See Viewing the network 
configuration, page 20.)

2. Open your preferred browser.

3. Type the printer’s IP address in the browser address (URL) bar, then press Enter.

Using the Online Printer Management Tool to configure your printer’s settings

With the Online Printer Management Tool open in your browser:

1. Select the Settings tab.

2. Click Device.

3. As needed, make changes to General or Date & Time settings, or Reset the 
printer setting to the factory defaults.

NOTE: Additional settings are available for Fax, Scan To, Copy, Print, and Security. 
These settings are discussed elsewhere in this guide.
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2 Networking Your Printer
This section explains how to configure your wireless network settings.

Connecting to a wireless network
To connect your printer to an 802.11b/g/n wireless (Wi-Fi) network, refer to the 
following information. 

Before you connect

You need:

• a wireless router.

• to determine whether your wireless router supports Wi-Fi Protected Setup 
(WPS).

NOTE: If you have specific questions about your router, see your router 
manufacturer’s documentation for more information.

For information, go to www.kodak.com/go/inkjetnetworking.

Connecting to a wireless network using the Wi-Fi Setup Wizard

You can use the Wi-Fi Setup Wizard on the printer to connect to your wireless 
network. Read the following procedures and use the one that is appropriate for your 
network setup.

Connecting to a non-WPS wireless router

To connect your printer to your wireless network, you need to know the network 
name, also called the Service Set Identifier (SSID). You can obtain your network 
name from the wireless router. 

If your network has security enabled, you also need to know the Security String 
(passphrase or password). 

Record your network information in the spaces below, using the correct uppercase 
and lowercase letters.

Network Name (SSID): ________________________________________

Security String (case-sensitive): ________________________________

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. With Wi-Fi Setup Wizard selected, press OK.

NOTE: The Wi-Fi radio turns on when you select Wi-Fi Setup Wizard.
www.kodak.com/go/aiosupport  15
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Networking Your Printer
The Wi-Fi connectivity LED blinks as the printer searches for available wireless 
networks within range, then displays the list in order of signal strength. For 
example:

If there are more networks than can be shown on the LCD, a  (page down) 
symbol appears in the bottom right of the display. 

4. Press  to select your network, then press OK. 

If you don’t see your network in the list, or if you want to change your network, 
select Rescan for Wireless Networks, then press OK.

NOTE: If the name of your network is not listed, make sure your wireless router 
is turned on and within range. If the name of your network is still not 
listed, go to www.kodak.com/go/inkjetnetworking for more information.

5. If your network requires a password, use the LCD keyboard to enter your 
Security String. The Security String is case-sensitive.

6. When the confirmation message appears, press OK.

On the control panel, press , , or  
to select the letters and numbers, using the 
correct uppercase and lowercase letters. 
Press OK after each character. When you are 
finished, select DONE, then press OK
16 www.kodak.com/go/aiosupport
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KODAK ESP Office 2100 Series All-in-One Printer
When the printer is successfully connected, the Wi-Fi connectivity LED will stop 
blinking and stay on steadily.

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESPOffice2150+0034). 

NOTE: If you are unable to connect your printer, go to 
www.kodak.com/go/inkjetnetworking for more information. 

7. If you haven’t yet installed the KODAK All-in-One Printer Software: 

a. Go to www.kodak.com/go/aiodownloads. 

b. In the results list, click the link for KODAK All-in-One Printer Software for 
your computer’s operating system.

c. Follow the on-screen instructions to install the software. 

Connecting to a WPS wireless router

If your router supports Wi-Fi Protected Setup (WPS), you can use WPS Connect. 
WPS lets you configure your printer for a wireless network by pressing buttons or 
entering a PIN.

To connect to a network using WPS:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. With Wi-Fi Setup Wizard selected, press OK.

NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup 
Wizard.

4. With WPS Connect selected, press OK.
www.kodak.com/go/aiosupport 17
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Networking Your Printer
5. Select one of two methods of connecting: 

IMPORTANT: Before you press OK on the printer, make sure you know where the 
router's push button is, or where to enter the generated PIN. If 
necessary, consult your Internet service provider or router device 
manufacturer’s documentation for more information.

6. When the confirmation message appears, press OK.

When the printer is successfully connected, the Wi-Fi connectivity LED stops 
blinking and stays on steadily.

NOTE: If you are unable to connect your printer, go to 
www.kodak.com/go/inkjetnetworking for more information. 

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESPOffice2150+0034).

7. If you haven’t yet installed the KODAK All-in-One Printer Software: 

a. Go to www.kodak.com/go/aiodownloads. 

b. In the results list, click the link for KODAK All-in-One Printer Software for 
your computer’s operating system.

c. Follow the on-screen instructions to install the software. 

Push Button Configuration Entering a PIN

NOTE: You will have two minutes 
between selecting Push Button 
Configuration on the printer and 
pressing or selecting the WPS 
button, which may be a button 
on the router or a virtual button 
in the router’s software.

a. With Push Button Configuration 
selected, press OK. 

b. Press or select the WPS button for 
your wireless router.

a. Press  to select Generate 
WPS PIN, then press OK.

b. In your wireless router’s software, 
locate the PIN screen.

c. Enter the PIN you received on the 
LCD into the router’s PIN screen. 
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KODAK ESP Office 2100 Series All-in-One Printer
Setting up an IP address
IMPORTANT: You should only need to set up an IP address for your printer if you are 

having a problem with connecting. Typically, it is not necessary to set up an 
IP address. This procedure is for advanced users who know how to obtain 
the IP address for the printer.

All IP address entries have the following format: 000.000.000.000. Within each 
three-digit grouping, the number must be right-justified. If an address or subnet 
mask has only one or two characters between the periods, include one or two 
leading zeros in front of that number. For example: 

For information about obtaining the printer IP address, go to 
www.kodak.com/go/inkjetnetworking.

To set up your IP address on the printer:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. Press  to select Advanced IP Address Setup, then press OK.

4. Press OK again to continue.

5. Select one of the following, then press OK:

• Dynamic (DHCP) 

• Manual (Static)
6. If you selected Manual (Static), you are prompted to enter an IP address, a 

Subnet Mask, a Gateway Address, and a DNS Server address. Press OK after 
each entry. Use the navigation buttons to enter each digit of the numbers.

Consult your Internet service provider or network administrator for more 
information.

The address as it may appear 
in your documentation

How to enter the address 
in the printer menu 

149.89.138.149 149.089.138.149

149.2.40.149 149.002.040.149
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Networking Your Printer
Viewing the network configuration
To view the network configuration and verify that you are connected to your wireless 
network:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. Press  to select View Network Configuration, then press OK.

The wireless network settings appear on the LCD, including:

• Printer Hostname

• Connection

• Speed 

• IP Address

• IP Address Type

• Network Subnet

• Connected Network SSID

• Security

• Authentication

• Channel

• Region

• Radio (on/off)

• MAC Address

If the printer is connected to your network, you will see the network name and 
the word CONNECTED. 

4. To scroll through the information, press . 

5. When you are done, press OK.

Printing the network configuration
To print the current network configuration:

1. Load plain paper into the printer. (See Loading plain paper, page 26.)

2. Press Home.

3. Press  to select Network Settings, then press OK.

4. Press  to select Print Network Configuration, then press OK.

Changing the printer name
When the Online Printer Management Tool is displayed in the browser (see 
Accessing the Online Printer Management Tool, page 14): 

1. Select the Network tab.

2. Click General, then Friendly name, if necessary.

3. Highlight the text in the Friendly name field and type the name you want, then 
click Save.
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KODAK ESP Office 2100 Series All-in-One Printer
Installing your printer on additional computers on the network

To add your printer to another computer(s) on your network, install the KODAK 
All-in-One Printer Software on each computer. 

1. Go to www.kodak.com/go/aiodownloads. 

2. In the results list, click the link for KODAK All-in-One Printer Software for your 
computer’s operating system.

3. Follow the on-screen instructions to install the software. 

Connecting to another KODAK All-in-One Printer

If you are connecting to a newer model printer (for example, you have an ESP 7 
printer and now you are adding an ESP Office 2150 printer), you must install the 
software for the newer model. 

NOTE: When you install the new software, the printer driver for the ESP 7 printer 
will be uninstalled, and an upgraded driver for the ESP 7 printer will be 
installed in addition to the driver for the ESP Office 2150 printer. 

On a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > Kodak Printer Network Setup Utility.

• If your wireless all-in-one printer (example: KodakESPOffice2150+0034) is 
not listed: 

a. Select No, my printer is not listed, then click Next.

b. From the drop-down list, select your printer.

c. Select Network - Wireless/Wi-Fi, then click Next.
When your printer is detected, driver installation begins.

• If your wireless all-in-one printer (example: KodakESPOffice2150+0034) is 
listed:

a. Highlight the all-in-one printer that is connected to your network.

b. Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

2. When driver installation is complete, click Done. 
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Networking Your Printer
On a computer with MAC OS:

1. Select Apple > System Preferences.

2. Under Hardware, select Print & Fax.

3. In the Print & Fax dialog box, click +.

4. Select your printer from the list, then click Add.

Adding a wireless network connection to a USB-connected computer
You can change the way you connect to your printer at any time.

Changing from USB to a wireless connection

To change the printer connection type from USB to a wireless (Wi-Fi) network:

If your printer is connected to a computer with WINDOWS OS:

1. Unplug the USB cable from your printer and computer.

2. On the printer control panel, press Home.

3. Press  to select Network Settings, then press OK.

4. Press  to select View Network Configuration, press OK, then confirm that the 
IP Address is not 0.0.0.0. 

5. If you have not already done so, connect your printer to your wireless network. 
See Connecting to a wireless network, page 15.

6. Select Start > All Programs > Kodak > Kodak Printer Network Setup Utility.

• If your wireless all-in-one printer (example: KodakESPOffice2150+0034) is 
not listed:

a. Select No, my printer is not listed, then click Next.

b. Select your printer from the list.

c. Select Network - Wireless/Wi-Fi, then click Next. 
When your printer is detected, driver installation begins.

• If your wireless all-in-one printer (example: KodakESPOffice2150+0034) is 
listed: 

a. Highlight the all-in-one printer that is connected to your network.

b. Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

7. When driver installation is complete, click Done. 

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESPOffice2150+0034).
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KODAK ESP Office 2100 Series All-in-One Printer
If your printer is connected to a computer with MAC OS:

1. Unplug the USB cable from your printer and computer.

2. On the printer control panel, press Home.

3. Press  to select Network Settings, then press OK. 

4. Press  to select View Network Configuration, press OK, then confirm that the 
IP Address is not 0.0.0.0.

5. Select Apple > System Preferences.

6. Under Hardware, select Print & Fax.

7. In the Print & Fax dialog box, click +.

8. Select your printer from the list, then click Add.

The printer with a wireless connection is listed as the name of the printer plus a 

number (for example, KodakESPOffice2150+0034). 
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3 Handling Paper
For the best document printing results, use KODAK Document Papers or a paper 
with the COLORLOK Technology logo on the package. Use only paper that is 
designed for inkjet printers.

For the best photo printing results, use KODAK Photo Papers, which are optimized to 
work with KODAK All-in-One Printers, or photo papers designed for use on 
pigment-based inkjet printers.

When handling photo paper:

• Hold the paper by the edges; avoid placing your fingerprints on it.
• Do not touch the glossy side of photo paper.
• Store paper flat, away from direct sunlight and heat.

Paper types
You can use: 

• Plain paper — 16 to 24 lb / 60 to 90 gsm
• Photo paper — up to 12 mils 
• Card stock — 110 lb / 200 gsm, max
• Envelopes — most standard types
• Labels — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets
• Transparencies — all commercially available inkjet varieties with a white strip on 

the long edge - 8.5 x 11-in. or A4 size

• Iron-on transfers — all commercially available inkjet varieties on 8.5 x 11-in. or 
A4 sheets

Paper sizes
The printer accepts the following paper sizes: 

• 4 x 6 in. / 10 x 15 cm
• 4 x 7 in. / 10 x 18 cm
• 4 x 8 in. / 10 x 20 cm
• 4 x 12 in. / 10 x 31 cm
• 5 x 7 in. / 13 x 18 cm
• 7.3 x 8.5 in. / 18 x 22 cm 
• 7 x 10 in. / 18 x 25 cm
• 7.3 x 10.5 in. / 18 x 27 cm 
• 8 x 10 in. / 20 x 25 cm
• 8.5 x 11 in. / 22 x 28 cm
• 8.5 x 14 in. / 22 x 36 cm
• A4 (8.3 x 11.7 in. / 21 x 30 cm) 
• A5 (5.8 x 8.3 in. / 15 x 21 cm)
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• A6 (4.1 x 5.8 in. / 11 x 15 cm)
• B5 (6.9 x 9.8 in. / 18 x 25 cm)

NOTE: Do not load paper smaller than 4 x 6 in. / 10 x 15 cm.

Envelope sizes
The printer accepts the following envelope sizes:

• C5 (6.7 x 9 in. / 16 x 23 cm)

• C6 (4.5 x 6.4 in. / 11 x 16 cm)

• DL (4.3 x 8.7 in. / 11 x 22 cm)

• US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

• US #9 (3.9 x 8.9 in. / 10 x 23 cm)

• US #10 (4.1 x 9.5 in. / 11 x 24 cm)

IMPORTANT: Do not load envelopes with cutout or clear windows. 

Loading paper
To load paper: 

1. Open and lift the paper input tray. 

2. Pull out the paper output tray and the extender until they are fully extended. 
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Handling Paper
Loading plain paper
The capacity of the paper input tray is 150 sheets of plain paper.

1. Fan and stack the paper.

2. Make sure the left and right paper-edge guides are in the far left and far right 
positions, then insert the paper into the input tray. 

3. Move the paper-edge guides until they touch the paper. 
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Loading photo paper 
The capacity of the paper input tray is 20 sheets of photo paper.

To load photo paper: 

1. Remove any paper from the input tray.

2. Insert the paper (short side first) into the center of the input tray with the logo 
side toward the tray and the glossy side toward you.

IMPORTANT: Always load the paper short side first. The printer automatically detects 
the orientation of the picture, whether it’s portrait or landscape, and prints 
accordingly. If the photo paper is loaded in the wrong direction, the image 
will be cut off and the paper may jam. If the paper is loaded with the wrong 
side up, the image quality will be affected. 

3. Move the paper-edge guides until they touch the paper. 
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Handling Paper
Loading envelopes
The capacity of the paper input tray is 20 envelopes.

IMPORTANT: Do not load envelopes with cutout or clear windows. 

To load envelopes: 

1. Remove any paper from the input tray.

2. Insert the envelope(s) into the tray with the with the flap side toward the tray 
and the top of the envelope against the right side of the tray.

3. Move the paper-edge guides until they touch the envelope(s). 
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Loading originals
You can place originals for copying, scanning, or faxing on the scanner glass or in the 
ADF (automatic document feeder). The ADF automatically feeds the originals into 
the printer when you begin copying, scanning, or faxing.

NOTE: Keep the scanner glass clean. Any dirt or smudges on the glass will appear 
as marks on the copy. See Cleaning the scanner glass and document 
backing, page 77.

Using the scanner glass

To place an original on the scanner glass:

1. Remove any originals from the automatic document feeder (ADF).

2. Lift the scanner lid, and place the document or picture face down in the 
right-front corner.

3. Close the scanner lid. 
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Handling Paper
Using the Automatic Document Feeder (ADF)
You can load up to 25 originals (20 to 24 lb / 75 to 90 gsm plain paper) in the 
automatic document feeder (ADF). 

The ADF accepts originals from 6.9 x 9.8 in. / 18 x 25 cm to 8.5 x 14 in. / 22 x 36 cm.

IMPORTANT: Do not load photographs, originals on thick paper, or a document that is too 
small or too large to fit in the ADF.

1. Remove any originals from the scanner glass.

2. Move the ADF paper-edge guides outward. 

3. Fan and stack the originals, then insert them face up in the ADF, with the top of 
the pages in first.

IMPORTANT: Remove all paper clips and staples from the originals.

4. Move the ADF paper-edge guides until they touch the paper. 

The ADF automatically feeds the originals into the printer when you begin copying, 
scanning, or faxing. 

ADF paper-edge guides
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4 Printing 
Print documents and lab-quality pictures on your printer. 

Printing documents
To print a document from your computer: 

1. Open the document. 

2. Select File > Print.

3. In the Print dialog box, select your KODAK Printer. 

4. Choose the pages to print, number of copies, etc, then click OK (on a computer 
with WINDOWS OS) or Print (on a computer with MAC OS). 

Printing two-sided documents

You can print two-sided documents on any size paper that the printer accepts (see 
Paper sizes, page 24) by rotating the paper manually as described below. 

IMPORTANT: Two-sided printing can only be done on media that can absorb ink on both 
sides, such as plain paper or two-sided photo paper. Two-sided printing will 
not work on bar-coded photo paper (the bar code is on the back side).

Printing two-sided documents from a computer with WINDOWS OS

To print two-sided documents from a computer with WINDOWS OS: 

1. Load paper into the paper input tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that your ESP Office 2100 Series Printer is 
selected (printers with a wireless connection have a 4-digit number added to 
the end of the name), then click Properties. 

4. Select the Layout tab. 

5. In the Two-sided printing field, select Manual (Instructions provided), then 
click OK to close the Properties window. 

6. Click OK to start the print job.

7. When a message appears on your computer or printer LCD telling you to do so, 
remove the printed pages from the output tray, and follow the instructions on 
the LCD.

8. Turn the printed pages over, and place them into the paper input tray (top edge 
down and printed side away from you). 

9. Press Start Black or Start Color on the printer. 

NOTE: It does not matter which Start button you press; the print job will continue 
printing in either color or black, depending on the document. 
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Printing two-sided documents from a computer with MAC OS

To print two-sided documents from a computer with MAC OS: 

1. Load paper into the paper input tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that your ESP Office 2100 Series Printer is 
selected (printers with a wireless connection have a 4-digit number added to 
the end of the name) is selected. 

4. Continue with the next steps, depending on the version of Home Center 
Software you have.

v6.1 v6.2 or higher

5. In the Copies & Pages list, select 
Paper Handling.

6. In the Pages to Print list, select Odd 
Only.

7. In the Page Order list, select 
Normal.

8. Click Print.
9. When the odd pages have finished 

printing, remove them from the 
output tray.

10.Turn the printed pages over, and 
place them into the paper input 
tray (top edge down and printed 
side away from you).

11. Select File > Print.
12.In the Copies & Pages list, select 

Paper Handling.
13.In the Pages to Print list, select 

Even Only.
14.In the Page Order list, select 

Normal.
15.Click Print.

5 In the Print dialog box, select the 
two-sided check box.

6 Click Print.
7. When the even pages have finished 

printing, follow the instructions on 
the printer LCD to reload the 
printed pages in the paper input 
tray.

8. Click Start on the printer control 
panel to print the odd numbered 
pages.
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Printing forms
You can print the following preprogrammed forms:

• Graph Paper

• Wide Ruled

• Narrow Ruled

• Grocery List

• Reminder List

• Tic-tac-toe

• Sheet Music (Portrait)

• Sheet Music (Landscape)

To print a preprogrammed form from the printer control panel:

1. Press Home.

2. Press  to select Printable Forms, then press OK.

3. Press  to select a form. 

4. Press or  to select a quantity (up to 99), then press OK. 

5. Press Start Black or Start Color on the printer. 

NOTE: It does not matter which Start button you press; the form will print in either 
color or black, depending on the form. 

Printing pictures
You can print pictures with your all-in-one printer from: 

• A memory card inserted into a memory card slot

• A storage device (such as a flash drive) or digital camera connected to the front 
USB port with a USB cable (KODAK ESP Office 2170 printer only)

• An iPhone, iPod Touch, or iPad device. For information, go to 
www.kodak.com/go/picflick. 

You can also print pictures using Home Center Software from your computer with 
WINDOWS OS. Home Center Software lets you edit and enhance your pictures 
quickly. Open Home Center Software, select Print Pictures, then follow the 
on-screen instructions.

On a computer with either MAC OS or WINDOWS OS, you can print pictures from 
any picture-editing or photo-management software. 
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Printing
Viewing pictures on a memory card or USB-connected device

NOTE: The option to use a USB-connected device, such as a digital camera or USB 
flash drive, is available only on the ESP Office 2170 printer.

When you insert a memory card into the memory card slot on your printer or a 
USB-connected device into the USB port, the pictures on the card or device appear 
on the LCD. Press or  to scroll through the pictures. 

If the printer is idle for more than two minutes, the LCD will revert to the status 
display. To view the pictures again, press any button, then press or .

Finding pictures on a memory card or USB-connected device

Your printer can help you locate pictures on a memory card or USB-connected 
device by the date the picture was taken or last saved. 

To locate pictures:

1. Insert the memory card into the memory card slot or the USB-connected device 
into the USB port (ESP Office 2170 printer only).

2. Press Home.

3. Press  to select View / Print Photos, then press OK.

4. Press  to select Find Photos, then press OK.

5. In the View by Date menu, press  to select Year, Month, or Day; press or  
to select the specific year, month, or day. 

The number of photos found for the date you specified appears under the menu 
name. To view pictures for the specified date, press OK.

6. Press OK to view the pictures.
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Printing from a memory card or USB-connected device
NOTE: The option to print from a USB-connected device, such as a digital camera or 

USB flash drive, is available only with the ESP Office 2170 printer.

You can print pictures from a USB-connected device (ESP Office 2170 printer only), 
and from the following cards inserted into the memory card slot on your printer:

• SD Card

• SDHC Card

• MMC Card

• MEMORY STICK

• Variations of the memory cards listed above that require an adapter (for 
example, MEMORY STICK Duo, miniSD, and microSD)

IMPORTANT: If you use a memory card with an adapter, make sure you insert and remove 
the adapter and the memory card as a unit; do not remove the memory card 
while leaving the adapter in the printer.

memory card slot

front USB port 
(ESP Office 2170 
printer only)
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Using default settings to print a picture

Unless you change the default settings, the default for printing pictures is one
4 x 6 in. / 10 x 15 cm picture. (To change the default settings, see Save as Defaults, 
page 38). 

To print a picture from a memory card or USB-connected device (ESP Office 2170 
printer only) using the default settings: 

1. Insert the memory card into the memory card slot, or connect a digital camera 
or USB flash drive to the front USB port. 

IMPORTANT: Do not use the memory card slot and the USB port at the same time. 

2. Press or  to select the picture you want to print. 

3. Press Start Black to print a black-and-white picture, or Start Color to print a 
color picture.

The printer prints a single 4 x 6 in. / 10 x 15 cm picture. 

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.

memory card slot

front USB port 
(ESP Office 2170
printer only)
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Changing the settings and printing pictures

You can change the print photos options for an individual picture or group of 
pictures, or you can change the settings and save them as the default. 

To print a picture or pictures using settings other than the default settings: 

1. Load photo paper with the glossy side toward you (see Loading photo paper, 
page 27), and move the paper-edge guides until they touch the paper.

2. Insert the memory card into the memory card slot, or connect a digital camera 
or USB flash drive to the front USB port (ESP Office 2170 printer only). A picture 
appears on the LCD. 

IMPORTANT: Do not use the memory card slot and the USB port at the same time. 

3. Press or  to select the picture you want to print, then press OK. 

4. Repeat step 3 for each picture you want to print.

5. Press Back for Remote Printing Settings. 

6. Press  to select an option (see table below), then press or  to change the 
setting. 

memory card slot

front USB port 
(ESP Office 2170
 printer only)

Print Photos Option Settings Description

View Photos -- Scroll through the pictures on the memory 
card or, with ESP Office 2170 printers only, 
the USB flash drive or connected digital 
camera; press OK to select the picture for 
printing; press Back to display the Print 
Photos Options menu. 
www.kodak.com/go/aiosupport 37



Printing
Find Photos -- Press OK, then select a year, month, and/or 
day to view photos by date that they were 
taken; press OK to view the photo(s); press 
Back to display the Print Photos Options 
menu.

Transfer All to PC -- To transfer all the pictures on the memory 
card (or for ESP Office 2170 printers, on the 
USB-connected device) to your computer, 
press OK then press Start Black or Start 
Color. (It does not matter which Start 
button you press, but your printer and 
computer must be connected with a USB 
cable.)

Quantity 1 (default) to 99 The number of copies that print.

Print Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

If the selected print size is smaller than the 
paper in the paper input tray, the printer 
automatically arranges the pictures to best fit 
the paper size. 

Plain Paper Quality Normal (default) Good quality output; prints faster than Best.

Best The highest quality, but the slowest print 
speed.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Auto. 
(default)

The printer detects when you load photo 
paper and sets Best quality automatically.

Scene Balance On (default)
Off 

Adjusts the image brightness to correct for 
underexposure and reduces the variation in 
contrast in different areas of the picture.

Add Date to Prints No (default)
Yes

Prints the date of the picture(s) (the date the 
picture was taken or last edited) in a corner of 
the print.

Save as Defaults No / Yes To save the settings as the new default, press 
OK. With Yes selected, press OK.

Print Photos Option Settings Description
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NOTE: You can also adjust the print photo options using the Online Printer 
Management Tool. When viewing the tool in your browser (see Accessing 
the Online Printer Management Tool, page 14), select the Settings tab, then 
select Copy & Print > Print Photo.

7. When you have finished changing settings, press Start Black to print a 
black-and-white picture, or Start Color to print a color picture.

IMPORTANT: To prevent loss of data from your memory card, camera, or USB flash drive, 
do not remove it from the printer while printing.

Printing panoramic pictures

To print a panoramic picture, load 4 x 12 in. / 10 x 31 cm paper, or US letter or A4 
paper in the paper input tray.

1. Insert the memory card into the memory card slot or a USB-connected device in 
the USB port (ESP Office 2170 printer only). 

2. Press or  to select the panoramic picture you want to print, then press OK.

3. Press Back for Remote Printing Settings. 

4. Press  to select Print Size, then press  to select 4 x 12.

5. Press Start Black to print a black-and-white picture, or Start Color to print a 
color picture. 

IMPORTANT: To prevent loss of data from your memory card, camera, or USB flash drive, 
do not remove it from the printer while printing.

memory card slot

front USB port 
(ESP Office 2170 
printer only)
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Printing
Printing tagged pictures

Some digital cameras let you tag (or “mark”) pictures on the memory card for 
printing. This creates a tag that is recognized by the printer. If you choose to print 
tagged pictures, they will print according to the default settings on your printer 
(unless otherwise specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine whether your camera supports 
tagged (also “marked” or “DPOF”) functionality.

To print tagged pictures:

1. Insert the memory card into the memory card slot or a USB-connected device 
into the front USB port (ESP Office 2170 printers only). 

2. When the “Print tagged images?” message appears, press Start Black to print a 
black-and-white picture, or Start Color to print a color picture. 

Printing from a wireless device
Wirelessly print pictures from an iPhone, iPod Touch, or iPad device* at the touch of 
a button. Download the KODAK Pic Flick App from the App Store, or go to 
www.kodak.com/go/picflick for more information. 

* Compatible with iPhone, iPad and iPod Touch (2nd Generation or later) devices. 
Requires iOS 3.0 or later.

memory card slot

front USB port (ESP 
Office 2170 printers 
only)
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Transferring pictures to a computer
You can transfer your image files from a memory card, or for ESP Office 2170 
printers, from a USB-connected device) in the printer to your computer. To transfer 
these files, the printer must be connected to your computer with a USB cable.

NOTE: If you have large video files or a large number of pictures (400 or more), we 
recommend that you transfer them using a memory card reader attached 
directly to your computer. 

Transferring pictures to a computer with WINDOWS OS
1. Insert the memory card into the card slot or the USB-connected device into the 

USB port (ESP Office 2170 printers only).

2. Press Back.

3. Press  to select Transfer All to PC, then press OK. 

4. Press Start Black or Start Color. 

NOTE: It does not matter which Start button you press. 

5. If your computer is connected to your printer using both a wireless network and 
a USB cable, select the USB-connected printer (no number after the printer 
name). 

6. Follow the on-screen instructions on your computer.

Transferring pictures to a computer with MAC OS
1. Insert the memory card into the card slot or the USB-connected device into the 

USB port (ESP Office 2170 printers only). 

2. Press Back.

3. Press  to select Transfer All to PC, then press OK. 

4. Press Start Black or Start Color. 

NOTE: It does not matter which Start button you press. 

5. If your computer is connected to your printer using both a wireless network and 
a USB cable, select the USB-connected printer (no number after the printer 
name). 

6. Use iPhoto or Image Capture on your computer to complete the transfer.
NOTE: You can adjust the Photo print settings using the Online Printer 

Management Tool. When viewing the tool in your browser (see Accessing 
the Online Printer Management Tool, page 14), select the Settings tab, then 
select Copy & Print > Print Photo.
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5 Copying
You can copy documents and photographs with your all-in-one printer. The printer 
produces high-quality color or black-and-white copies on a variety of paper types 
(see Paper types, page 24). 

Loading originals for copying
To copy documents (up to 25 pages) on plain paper, load the original(s) in the 
automatic document feeder (ADF). 

To copy a photograph, documents on thick paper, or a document that is too small or 
too large to fit in the ADF, place the original on the scanner glass. (The ADF accepts 
originals from 6.9 x 9.8 in. / 18 x 25 cm to 8.5 x 14 in. / 22 x 36 cm.)

For more information on loading originals, see Loading originals, page 29.

Copying a document
You can copy a document using the default settings, or you can adjust the quantity, 
size, quality, and brightness of your copies. 

Using the default settings to copy a document 

The default settings are either the factory default settings (see Resetting factory 
defaults, page 84), or defaults that you have set on the printer (see Save as Defaults, 
page 43). 

To copy a document using the current default settings:

1. Place the original document in the ADF or on the scanner glass.

2. Press Copy.

3. Press Start Black to make a black-and-white copy, or press Start Color to make a 
color copy. 

NOTE: If you load the original document in the ADF, the ADF automatically feeds 
the document into the printer when you begin copying. 

Adjusting the settings and copying a document

To copy a document using settings other than the default settings:

1. Place the original document in the ADF or on the scanner glass.

2. Press Copy. 

The Copy Document Options menu appears on the LCD. 
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3. Press  to select an option, then press or  to change the setting.

4. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 

Copy Document 
Option

Settings Description

Quantity 1 (default) to 99 The number of copies that print.

Copy Size Same Size 
(default)

The copy is the same size as the 
original.

Fit to Page The printer detects the size of the 
original on the scanner glass and the 
size of the paper in the paper tray, and 
automatically reduces or enlarges the 
original so that the copy fits on the 
paper.

20% to 500% Reduces up to 20% or enlarges up to 
500% of the original size.

Plain Paper Quality Normal
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Auto. 
(default)

The printer detects photo paper in the 
paper tray and sets Best quality 
automatically.

Brightness Normal, -3 to +3 
(Normal is default) 

Lightens or darkens the copy. 
Normal is no change from the original; 
-3 is the darkest; +3 is the lightest.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes selected, 
press OK.
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Changing the number of copies of a document
To change the number of copies:

1. Place the original document in the automatic document feeder (ADF) or on the 
scanner glass.

2. Press Copy. 

The Copy Document Options menu appears on the LCD. 

3. Make sure Quantity is selected. 

4. Press  or  to select a number, or use the numeric keypad to enter the 
number of copies. 

5. Press Start Black to make black-and-white copies, or press Start Color to make 
color copies. 

Enlarging or reducing a document

To enlarge or reduce the size of the copy:

1. Place the original document in the automatic document feeder (ADF) or on the 
scanner glass.

2. Press Copy. 

The Copy Document Options menu appears on the LCD. 

3. Press  to select Copy Size.

4. Press  or  to select an enlargement or reduction.

5. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 

Darkening or lightening a copy

To darken or lighten the copy:

1. Place the original document in the automatic document feeder (ADF) or on the 
scanner glass.

2. Press Copy. 

The Copy Document Options menu appears on the LCD. 

3. Press  to select Brightness.

4. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

5. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 
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Copying a photograph
You can copy a photograph using the default settings, or you can make adjustments 
to the quantity, size, quality, and brightness of your copies. 

Using the default settings to copy a photograph 

The default settings are either the factory default settings (see Resetting factory 
defaults, page 84), or defaults that you have set on the printer (see Save as Defaults, 
page 46). 

To copy a photograph using the current default settings:

1. Place the original photograph face down on the scanner glass.

IMPORTANT: Do not load photographs in the automatic document feeder (ADF). 

2. Press Home.

3. Press  to select Copy Photo.

4. Press Start Black to make a black-and-white copy, or press Start Color to make a 
color copy. 

Adjusting the settings and copying a photograph

To copy a photograph using settings other than the default settings: 

1. Place the original photograph face down on the scanner glass. 

IMPORTANT: Do not load photographs in the automatic document feeder (ADF). 

2. Press Home. 

3. Press  to select Copy Photo, then press OK. 

4. Press  to select an option, then press or  to change the setting. 

Copy Photo Option Settings Description 

Quantity 1 (default) to 99 The number of copies that print.

Copy Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12 

8 x 10

8.5 x 11 or A4

The printer enlarges or reduces the 
original to make it the copy size you 
select. 

If the selected copy size is smaller 
than the paper in the paper tray, the 
printer automatically arranges the 
pictures to best fit the paper size. 

Some cropping may occur if the image 
size and the selected print size are 
different.
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5. Press Start Black to make a black-and-white copy, or press Start Color to make a 
color copy. 

Plain Paper Quality  Normal 
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Automatic
(default)

The printer detects photo paper in the 
paper tray and sets Best quality 
automatically.

Brightness Normal, -3 to +3 
(Normal is default) 

Lightens or darkens the copy. 
Normal is no change from the original; 
-3 is the darkest; +3 is the lightest.

Preview No (default) / Yes To see a preview of the photograph on 
the LCD, select Yes. 

Save as Defaults No / Yes To save settings as the new default, 
press OK, select Yes, then press OK.

Copy Photo Option Settings Description 
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Changing the number of copies of a photograph
To change the number of copies:

1. Place the original photograph face down on the scanner glass.

2. Press Home.

3. Press  to select Copy Photo, then press OK.

4. Make sure Quantity is selected. 

5. Press  or  to select a number, or use the numeric keypad to enter the 
number of copies. 

6. Press Start Black to make black-and-white copies, or press Start Color to make 
color copies. 

Enlarging or reducing a photograph

To enlarge or reduce the size of the copy:

1. Place the original photograph face down on the scanner glass. 

2. Press Home.

3. Press  to select Copy Photo, then press OK.

4. Press  to select Copy Size.

5. Press  or  to select the copy size.

6. Press Start Black to make a black-and-white copy, or press Start Color to make a 
color copy. 

Darkening or lightening a copy of a photograph

To darken or lighten the copy of the photograph:

1. Place the original photograph face down on the scanner glass. 

2. Press Home.

3. Press  to select Copy Photo, then press OK.

4. Press  to select Brightness.

5. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

6. Press Start Black to make a black-and-white copy, or press Start Color to make a 
color copy. 
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Scanning digitizes documents and pictures, and sends the digital files to your 
computer, memory card, email, network folder, or USB flash drive (ESP Office 2170 
printer only).

To scan to a computer, the Home Center Software must be installed on that 
computer, unless you are using the Online Printer Management Tool. (See Scanning 
from the Online Printer Management Tool, page 59.)

When you scan, the digital file can: 

• Open in Home Center Software (when Home Center Software is loaded and the 
printer is connected to a computer with WINDOWS OS)

• Open in a third-party scanner software

• Be saved in a format and location that you determine (see Changing the scan 
settings for scanning from the printer control panel, page 48)

Scanning from a software program on the computer (such as Home Center 
Software) gives you more options, but you can also scan from the printer control 
panel.

Before you begin scanning
If you are scanning to a computer, make sure that the printer is connected to a 
computer using a USB cable or wireless network (see Networking Your Printer, 
page 15).

If you want to scan to an email address or to a shared network folder, you need to: 

• make sure the printer is connected to a computer using a wireless connection

• set up profiles using the Online Printer Management Tool (see Adding a profile 
and address book for Scan To Email, page 51 and Adding a profile for Scan To 
Network Folder, page 53)

Changing the scan settings for scanning from the printer control panel

Adjust the scan settings that the printer uses before you scan from the printer 
control panel.

NOTE: The settings in the Home Center Software only apply when Scanning to 
Computer, Scanning to Memory Card, or Scanning to Flash Drive (ESP Office 
2170 printer only) from the printer control panel.

1. Open the Printer Tools window. 

• On a computer with WINDOWS OS, select Start > All Programs > Kodak > 
Kodak AiO Printer Tools.

• On a computer with MAC OS, open Home Center Software, then select the 
Tools tab. 

2. Under the Tools heading, select Printer Scan Settings. 
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3. Adjust settings for scanning documents and pictures:

a. To select a program that scanned images or documents will appear in when 
you scan from the printer control panel: 

(1)Select the General tab.

(2)Under the Program List heading, click  next to the currently selected 
program.

(3) From the list, select the program in which you want the scanned files to 
open. 

b. To adjust settings for scanning documents, select the Document tab, then 
select an option for each setting:

Setting Options

Scan As Black and white

Color 

Grayscale

File format .pdf 
.rtf (available only when connected to a computer 

with WINDOWS OS)
.tif 

.jpg

.bmp (available only when connected to a computer 
with MAC OS)

Resolution (dpi) 75
150
200 
300

File Save Prompt for File Name and Location
Automatically Save - specify:
• Base name; by default, scanned files are names 

“scan1”, “scan2”, and so on.
• Location (folder) where the scanned files will be 

saved
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c. To adjust settings for scanning pictures, select the Picture tab, then select an 
option for each setting:

NOTE: If you scan from within Home Center Software, or scan to Home Center 
Software from the front panel, before you save a scanned file, you will be able to 
preview it in Home Center Software, crop and sharpen the image, and adjust 
color, if desired. On a computer with WINDOWS OS, see the Home Center 
Software Help (? icon) for instructions.

Setting Options

Scan As Color 

Black and white

File format .jpg
.bmp
.tif

Resolution (dpi) 75
150
200

300

600

Quality When connected to a computer with WINDOWS 
OS:

• Best for E-mail
• Normal
• High
• Maximum
When connected to a computer with MAC OS, 
a slider bar with:
• Least
• Medium
• Best

Automatically Detect 
Pictures (when connected 
to a computer with 
WINDOWS OS) or Auto 
Crop (when connected to a 
computer with MAC OS)

When selected, multiple pictures placed on the 
scanner glass are saved as separate files.

File Save Prompt for File Name and Location
Automatically Save - specify:
• Base name; by default, scanned files are names 

“scan1”, “scan2”, and so on.
• Location (folder) where the scanned files will be 

saved
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4. When you are finished making selections, click OK on the bottom right of the 
Printer Scan Settings window. 

5. Close the Printer Tools window. 

Adding a profile and address book for Scan To Email

You can send one or more scans directly to an email recipient from the printer, but 
first you need to set up a profile for yourself and define one or more email addresses.

1. Open the Online Printer Management Tool in a browser (see Accessing the 
Online Printer Management Tool, page 14).

2. Select the Settings tab, then click Scan To Email > Email Profile.

3. Click Add New Outgoing Email Profile.

4. In the Profile Name field, type a name that has meaning to you; for example, 
your initials and your email provider, such as AZ Hotmail or AZ Gmail. 
This name will appear on the control panel for you to select when initiating a 
scan to be sent through email.

5. For From Email Address, type your email address. 
Although the email will be sent from the printer, any replies will go to your Inbox.
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6. Enter your server information. This information can be obtained from the email 
account properties fields in your email client application (Outlook Express, 
Outlook, Eudora, etc) under the Outgoing mail server configuration section or 
directly from your ISP.

a. In the SMTP Server field, type the name or IP address of your server for 
sending emails.

b. In the SMTP Port Number, type the port number of your server for sending 
emails.

c. If your mail server (ISP) supports secure connection mode, select the Always 
use secure connection check box. 

7. If your SMTP server requires authentication when you connect from your email 
client application:

a. Select the The email server requires authentication for outgoing email check 
box.

b. Type the User ID and Password for your email account.

8. If you want to control who is able to use your profile for sending a scan using 
your email account:

a. Select the Enable Access Pin check box.

b. Type a 4-digit numeric PIN (your choice). You will need to enter this PIN each 
time you access your profile when scanning to an email address.

9. Click Test Profile to have the printer confirm that it can access your account on 
the SMTP server.
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10. Enter email addresses of people to whom you want to send scans by email.

a. Click the Address Book selection in the menu to the left.

b. For each person: 

 (1) Type the person’s Name.

 (2) Type the person’s Email Address.

 (3) Click Add.

You are now ready to send a scan to an email address from the printer control panel. 
See Scanning from the control panel, page 57

Adding a profile for Scan To Network Folder

You can scan documents or photos directly to a file in a shared folder on your 
network. This saves time and allows you to keep a permanent record. 

To add a network folder profile on your printer’s control panel, you first need to 
identify or create a network shared folder on a computer connected to the same 
network as your printer. Note the network name of the folder, including the path 
information, and the name of the computer where it is located. 

To learn more about sharing folders, see the information in the links below.

• For computers with WINDOWS XP OS, see 
www.microsoft.com/windowsxp/using/networking/maintain/share.mspx

• For computers with WINDOWS VISTA OS, see 
technet.microsoft.com/en-us/library/bb727037.aspx
www.kodak.com/go/aiosupport 53



Scanning
• For computers with WINDOWS 7 OS, see 
windows.microsoft.com/en-US/windows7/File-sharing-essentials

• For computers with MAC OS 10.4, see 
docs.info.apple.com/article.html?path=Mac/10.4/en/mh1161.html

• For computers with MAC OS 10.5 or later, see support.apple.com/kb/ht1549

1. Open the Online Printer Management Tool in a browser (see Accessing the 
Online Printer Management Tool, page 14).

2. Select the Settings tab, then click Scan to Network Folder > Network Folder 
Profile. 

3. Click Add New Network Folder Profile.
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4. Type a Profile Name and a Folder Path.

5. If the computer where the folder is located requires authentication to access its 
shared folders, type the network login User Name and Password.

6. If you want to control who is able to use your profile to scan documents to your 
network folder, select the Enable Access PIN check box and type a 4-digit 
numeric PIN.

7. Click Test Profile to have the printer confirm that it can access the network 
folder.

You are now ready to scan a document or photo to your network folder from the 
printer control panel. See Scanning from the control panel, page 57

Loading originals for scanning
To scan documents (up to 25 pages) on plain paper, load the original(s) in the 
automatic document feeder (ADF). 

To scan a photograph, documents on thick paper, or a document that is too small or 
too large to fit in the ADF, place the original on the scanner glass. (The ADF accepts 
plain paper originals from 6.9 (18 cm) to 8.5 (22 cm) wide and 9.8 in. (25 cm) to 14 
in. (36 cm) long

For more information on loading originals, see Loading originals, page 29.
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Scanning from the computer
To scan a document or a picture: 

1. Load the original.

2. Open Home Center Software. 

• On a computer with WINDOWS OS, double-click Scan Documents and 
Pictures, then follow the on-screen instructions.

• On a computer with MAC OS and Home Center Software, select the Tools 
tab, click Scan Application, then follow the on-screen instructions. 

NOTE: If you are not using Home Center Software, open a program that allows you 
to scan, then follow the instructions.

Scanning multiple pictures simultaneously

Using Home Center Software, you can scan multiple pictures simultaneously and 
save them as separate files. 

When scanning multiple pictures, leave space between the pictures so that the 
printer can detect the separate pictures. Any pictures that overlap are interpreted as 
a single picture. 

Scanning multiple pictures when connected to a computer with WINDOWS OS

To scan multiple pictures simultaneously, and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures. 

2. Close the lid. 

3. Open Home Center Software, then double-click Scan Documents and Pictures. 

4. Make sure that Picture is selected and Collage - Combine all pictures is cleared, 
then follow the on-screen instructions.

NOTE: Click the Help icon for additional instructions. 

Scanning multiple pictures when connected to a computer with MAC OS

To scan multiple pictures simultaneously, and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures. 

2. Close the lid. 

3. Open Home Center Software, then select your printer.

4. Select the Tools tab.

5. Click Scan Application.

6. Select Color Picture or Black and White Picture. 

7. Select Automatically detect multiple pictures, if it is not selected.

8. Click Preview or Scan All, then follow the on-screen instructions.

NOTE: Click the Help icon for additional instructions. 
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Scanning from the control panel
To scan a document or picture(s) from the control panel: 

1. Load the original.

2. Press Scan. 

The Scan Menu appears on the LCD with the following options: 

• Scan to Computer - used to scan to a file or Home Center Software on your 
computer; in Home Center, you can select from a list of applications that you 
can open directly with the scanned image 

• Scan to Memory Card - used to scan to a memory card

• Scan to Flash Drive (ESP Office 2170 printer only) - used to scan to a USB 
flash drive

• Scan to Email - used to scan to an email address

• Scan to Network Folder - used to scan to a shared network folder
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3. Press  to select an option, then press or  to change the setting.

NOTE: The Scan to email and Scan to network folder features in the Online Printer 
Management Tool have additional options that are not listed here.

Scan Option Settings Description

Scan To USB Computer
(default)

The scanned document or picture is 
sent to a file or folder, based on the 
settings defined in Changing the scan 
settings for scanning from the printer 
control panel, page 48.

Name of computer 
(only if a computer is 
connected by wireless 
network)

The scanned document or picture is 
sent to a file or folder, based on the 
settings defined in Changing the scan 
settings for scanning from the printer 
control panel, page 48.

Memory Card The scanned file is sent to the memory 
card in one of the memory card slots.

USB Flash Drive (ESP 
Office 2170 printer 
only)

The scanned file is sent to the flash drive 
attached to the front USB port. 

Email The scanned file is sent to an email 
address that you select from the Email 
Profile you set up in the Online Printer 
Management Tool (see Adding a profile 
and address book for Scan To Email, 
page 51).

Network Folder The scanned file is sent to a shared 
folder that you designated in the Online 
Printer Management Tool (see Adding a 
profile for Scan To Network Folder, 
page 53).

Scan What Document
(default)

Sets the scan settings for scanning a 
document (see Changing the scan 
settings for scanning from the printer 
control panel, page 48).

Photo Sets the scan settings for scanning a 
photograph (see Changing the scan 
settings for scanning from the printer 
control panel, page 48).
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4. Press Start Black to make a black-and-white scan, or press Start Color to make a 
color scan. 

The scanned file appears at the destination you specified. 

Scanning from the Online Printer Management Tool
You can use an Internet browswer to initiate a scan from within the Online Printer 
Management Tool on a computer that is connected to the same network as the 
printer. The computer does not need the All-in-One Printer Software (or drivers) 
installed. 

1. When viewing the Online Printer Management Tool in a browser (see Accessing 
the Online Printer Management Tool, page 14), select the Applications tab, then 
click Applications > Webscan.

2. Select the type of scan you want, and place the original on the scanner glass.

3. Click Preview to see what will be scanned.

• If needed, click Clear to reposition the image.

4. When you are satisfied with the image, click Scan to capture the image. It will 
display in a new browser window.

5. In the new browser window, select File > Save As to save the image as a JPEG 
file on your computer. 

Destination File
(default)

Sends the scanned file in the format 
and to the location on your computer 
that you designate (see Changing the 
scan settings for scanning from the 
printer control panel, page 48).

Application Sends the scanned file to Home Center 
Software.

Save as 
Defaults

No / Yes To save the settings as the new default, 
press OK. With Yes selected, press OK.

Scan Option Settings Description
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Your printer can send and receive faxes in either black-and-white or color. 

Before you begin faxing
Before you can send or receive faxes, you must connect your printer and set up the 
fax options on the printer.

Connecting the printer for faxing

Selecting the country/region

For the fax to work properly, the country or region selected on the printer must 
match your location. This setting determines how your faxes are sent and received. 

To set the correct country or region:

1. Press Home.

2. Press  to select Printer Settings, then press OK.

3. Press  to select Country/Region, then press OK.

4. Press  to select your country or region, then press OK.

Determining your telephone system type

The instructions for setting up your printer for faxing differ depending on the type of 
telephone service you have. Determine the type of telephone service you have, and 
connect your printer accordingly. 

IMPORTANT: Use the phone cord that was provided with the printer. If you use any other 
phone cord, you may not be able to send or receive faxes successfully.

• Standard telephone service — telephone service that uses dedicated telephone 
wiring to transmit only phone signals 

• Cable telephone service — telephone service that is delivered by a cable 
television service

• Digital Subscriber Line (DSL) — telephone service that uses the wires of a local 
telephone network to transmit digital data over cables

• Internet telephone service (Voice-Over-Internet-Protocol or VOIP) — 
telephone service delivered by an Internet provider 
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Connecting the 
printer to a Standard 
or Cable telephone 
service 

If you have Standard or Cable telephone service, connect one end of the phone cord 
that came with the printer into the LINE IN port on the back of the printer and the 
other end into the wall phone jack.

Connecting the 
printer to a Digital 
Subscriber Line 
(DSL) 

If you have DSL telephone service, connect one end of the phone cord that came 
with the printer into the LINE IN port on the back of the printer and the other end 
into the DSL filter (available from your DSL provider), which is connected to the wall 
phone jack. 

NOTE: You must use a DSL filter to transmit fax signals properly to your printer.

DSL filter
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Connecting to 
Internet telephone 
service 
(Voice-Over-Internet 
Protocol or VOIP)

If you have Internet telephone service, you should already have a cable 
modem/router connected to the cable outlet with a coaxial cable. You will also need 
an Analog Telephone Adapter (ATA) to connect your printer for faxing. 

NOTE: Sometimes the cable modem/router has a built-in ATA. Contact your cable 
telephone service provider for more information. 

1. Connect an RJ-45 (also called CAT 5) cable from the cable modem/router to the 
WAN port on the Analog Telephone Adapter (ATA). 

2. Connect one end of the phone cord that came with the printer (RJ-11 telephone 
cord) to one of the phone input ports on the ATA and the other end to the LINE 
IN port on the back of your printer. 

Coaxial 

RJ-45 cable 
RJ-11 

Cable outlet

Cable 

Analog Telephone 

modem/router

Adapter (ATA)

(CAT 5 cable)
telephone cord

cable
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Determining whether your phone line is dedicated or shared

To connect your printer for faxing correctly, you need to determine whether your 
phone line is shared or dedicated

• A dedicated phone line is one that has only this printer and no other devices 
connected to it. If you have a dedicated line, connect your printer as described 
for your type of phone service (see Connecting the printer to a Standard or 
Cable telephone service, page 61, Connecting the printer to a Digital Subscriber 
Line (DSL), page 61, or Connecting to Internet telephone service 
(Voice-Over-Internet Protocol or VOIP), page 62). 

• A shared phone line is one that has several devices connected to it, such as a 
phone and/or answering machine as well as the printer. If you have a shared line, 
connect your printer in one of the following ways, based on the devices you have 
connected to the same phone line. 

If you share the line with an answering machine or telephone:

1. Connect one end of the phone cord that came with the printer into the LINE IN 
port on the back of the printer.

2. Connect the other end of the phone cord into a wall phone jack, DSL filter, or 
ATA, depending on the type of telephone service you use.

3. Connect one end of the phone cord for your answering machine into the LINE EX 
port on the back of the printer.

4. Connect the other end of the phone cord into the answering machine or 
telephone.

NOTE: If you have an answering machine, set the number of rings to answer on the 
printer to a higher number than the rings to answer for the answering 
machine (see Rings to Answer, page 65).

Phone with 

Configuration for connecting an answering 
machine with a standard telephone service

answering machine
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If you have an answering service:

If you have an answering service that uses a computerized system for recording 
messages remotely for the same phone line that you use for your all-in-one 
printer, then you can set up a distinctive ring to receive faxes automatically (see 
Distinctive Ring, page 66).

If you do not set up a distinctive ring, you can still receive faxes manually (see 
Receiving a fax manually, page 74). 

Entering fax sender information

Fax sender information is the name, fax, and phone number that appear in the 
header of any fax that you send from your all-in-one printer. Typically this is your 
name or your business name, your fax number, and your phone number. 

NOTE: If you do not enter fax sender information, the header on faxes that you send 
will be blank.

To enter fax sender information:

1. Press Home.

2. Press  to select Fax Settings, then press OK
3. With Fax Sender Information highlighted, press OK. 

4. Use the numeric keypad on the control panel to enter:

• your name or business name

• your fax number

• your phone number

See Using the numeric keypad on the control panel to enter text and/or 
numbers, page 70 

5. When you are finished entering information in a field, press . to move to the 
next field. 

6. Press OK to save the information. 
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Setting fax options
Before sending or receiving faxes, set up the fax options. 

To set up fax options from the control panel:

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. Press  or  to select an option, then press or  to change the setting. 

Fax Option Settings Description

Fax Sender 
Information

-- This information appears on the faxes 
you send. 

Press OK, then enter the fax sender 
name (your name), your fax number, and 
your phone number (see Using the 
numeric keypad on the control panel to 
enter text and/or numbers, page 70); 
press OK to save.

Rings to Answer 1 to 6 (default is 4) The number of times that your phone 
will ring before the printer picks up the 
call. 

If you use a dedicated phone line for your 
printer, set the Rings to Answer to any 
setting. If the printer shares the phone 
line with an answering machine, set the 
Rings to Answer to a higher number (5 
or 6) than the rings to answer for the 
answering machine (typically 4 rings). 
This allows the answering machine to 
pick up phone calls. The printer will 
monitor the line after the answering 
machine picks up, and, if set to Auto 
Answer, will detect an incoming fax and 
receive it. 

Redial if No Answer Yes (default) / No If the number you call is busy, the printer 
will redial the number once 
automatically. 

Busy Redial 
Attempts

0 to 12

(default is 5)

The number of times that the fax will 
attempt to redial a busy number. 
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Disable Call Waiting No (default) / Yes If you have call-waiting service on your 
phone line, you can disable it so that an 
incoming call does not interrupt your fax 
transmission.

Select Yes to disable call waiting, then 
enter the call waiting disable code 
(below). 

Call Waiting Disable 
Code

*70 (default) The printer automatically dials the call 
waiting disable code before dialing the 
number to which you are sending a fax. 
This code disables call waiting for the 
duration of the fax, preventing incoming 
calls from interrupting your fax 
transmission. 

The usual code to disable call waiting is 
the default *70. If the call waiting disable 
code is different in your area, press OK, 
then press  to erase the current code. 
Use the keypad to enter the correct 
code, then press OK. 

NOTE: You must enable call waiting 
manually after your fax 
transmission.

Distinctive Ring Any ring (default) / 
Single Ring / Double 
Ring / Triple Ring

This service, available from most phone 
companies, adds multiple phone 
numbers to one phone line. Each phone 
number then has a distinctive ring 
pattern (single, double, or triple ring) to 
let you know which number is ringing. 

Select the ring pattern assigned to the 
phone number for the printer so the 
printer can receive faxes automatically. 

Fax Speed Fast - 33.6K (default)
Medium - 14.4K
Slow - 9.6K

Use this setting to reduce the fax 
transmission speed of your printer if you 
have difficulty with faxing at higher 
speeds.

Fax Speaker On (default) / Off The fax speaker allows you to hear the 
dial tone and initial fax tones when 
sending faxes.

Print Fax 
Confirmation Page 

Never (default) / 
Always / After Failure 
Only 

The Fax Confirmation Page contains the 
time and date, the number you called, 
the number you called from, and 
whether the transmission was 
successful. 

Fax Option Settings Description
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To adjust fax settings from the Online Printer Management Tool: 

1. Open the Online Printer Management Tool in a browser (see Accessing the 
Online Printer Management Tool, page 14).

2. Select the Settings tab, then click Fax > Settings. 

Print Fax Settings -- To print the current fax settings, press 
OK. Load letter or A4 paper, then press 
Start Black or Start Color. 

Print Fax Cover Page -- The Fax Cover Page shows the date and 
headings for To and From information for 
your fax. Use this cover page, if needed, 
when sending your fax.

To print a Fax Cover Page, press OK. 
Load letter or A4 paper, then press Start 
Black or Start Color. (The Fax Cover 
Page is black and white.)

Print Fax Activity Log -- The Fax Activity Log contains 
information (date, time, duration, 
to/from, number of pages, and more) 
about the last 30 faxes sent and/or 
received.

To print a Fax Activity Log, press OK. 
Load letter or A4 paper, then press Start 
Black or Start Color. 

Dialing Mode Tone (default) / Pulse Determines how the printer dials a fax 
number. 

Tone dialing (the more common 
method) uses tones to dial a phone 
number. It is faster and more reliable 
than pulse dialing, which uses a series of 
pulses to dial a phone number.

Traditionally, pulse dialing was used by 
rotary phones; tone dialing is used by 
touch-tone phones.

Error Correction On (default) / Off Error correction is applied only when 
sending black-and-white faxes. It 
reduces the loss of data, which can occur 
on poor phone lines. 

Error correction increases the send time 
on poor phone lines, but the 
transmission is much more reliable. 
(Error correction does not apply to faxes 
being received.)

Fax Option Settings Description
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3. Change the Sender Information and/or fax Settings as needed.

4. Click Save to update the settings on the printer.

Setting the answer mode (auto answer or manual)

The default setting is for Auto Answer to be on. When Auto Answer is on, the 
printer picks up all incoming faxes automatically. The green Auto Answer LED is lit 
when Auto Answer is on. 

To answer calls manually, turn off Auto Answer by pressing the Auto Answer button 
so that the green LED is off. (See Receiving a fax manually, page 74.)

Working with the phonebook

You can enter up to 60 fax numbers in the phonebook. 

You can create and manage the phonebook from the printer LCD, or if connected to a 
computer with WINDOWS OS, you can use Home Center Software. 

You can also use the Online Printer Management Tool to edit the Fax Phone Book. 
See Using the Online Printer Management Tool to edit the Fax Phone Book, page 70

Using symbols in phonebook entries

The following symbols are used in phonebook entries: 

Symbol Description Response by fax

0 - 9 numbers Dials number

* star Used for special features (for example, *70 is used to 
deactivate call waiting)

, comma Causes a 2-second delay before dialing the remaining 
numbers

# pound Used for special features (for example, # at the end of a 
number signifies the completion of the number sequence)
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Adding a new phonebook entry

To add a new phonebook entry: 

1. Press Phonebook. 

2. Make sure Edit Phonebook is selected, then press OK. 

3. Make sure Add New Entry is selected, then press OK.

4. Make sure Number is selected, then press OK.

5. Use the numeric keypad on the control panel to enter a fax number, then press 
OK. 

6. With Name selected, press OK.

7. Enter a name using the numeric keypad (see Using the numeric keypad on the 
control panel to enter text and/or numbers, page 70).

8. When you are finished entering a name, press OK.

9. Optional: Assign a Quick Dial number.

Set up your ten most frequently used fax numbers as Quick Dial numbers. You 
will be able to dial them quickly, and they will be displayed at the top of your 
phonebook. 

a. Press  to select Quick Dial, then press OK.

b. Using the numeric keypad on the control panel, enter a number from 0 to 9, 
then press OK.

10. Press  to select DONE, then press OK.

Editing a phonebook entry

To edit a phonebook entry: 

1. Press Phonebook. 

2. Make sure Edit Phonebook is selected, then press OK. 

3. Press  to select Edit Entry, then press OK.

4. Press  to select the entry you want to edit, then press OK.

5. Press  to select the field you want to edit, then press OK. 

6. Use the or the numeric keypad (see Using the numeric keypad on the control 
panel to enter text and/or numbers, page 70) to make your change(s). 

7. Press  to select DONE, then press OK.
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Deleting a phonebook entry

To delete a phonebook entry: 

1. Press Phonebook. 

2. Make sure Edit Phonebook is selected, then press OK. 

3. Press  to select Delete Entry, then press OK.

4. Press  to select the entry you want to delete, then press OK.

NOTE: If you do not want to delete the entry, press Cancel.

5. To delete the entry, press OK. 

The entry is deleted from the phonebook.

6. Repeat steps 4 – 5 to delete more entries; when you are finished, press Back or 
Cancel.

Using the numeric keypad on the control panel to enter text and/or numbers

The number keys on the numeric keypad represent a number and several characters. 
For example, the number 2 key also represents the letters A, B, C and a, b, and c. You 
must press the 2 key multiple times to enter a corresponding letter. For example, to 
enter the letter “B” as the first letter of a name, press the 2 key two times; to enter 
the small letter “b” at the beginning of a name, press the 2 key five times. If the small 
letter “b” is not at the beginning of a name or word, press the 2 key two times. 

If you need to use the same key for more than one letter in a row (for example, to 
type “Cab”), you need to pause between letters. To type “Cab”, press the 2 key three 
times to enter “C”, then pause 3 to 4 seconds; press the 2 key once to enter “a”, then 
pause for 3 to 4 seconds; and press the 2 key two times to enter “b”. You do not need 
to pause if the next letter is on a different key.

Note that the Symbols (*) key and the Space (#) key also cycle through several 
different symbols when you press the key multiple times. 

To make a correction to your entry, press  (navigation button) on the control panel 
to erase the rightmost character. 

Using the Online Printer Management Tool to edit the Fax Phone Book
1. Open the Online Printer Management Tool in a browser (see Accessing the 

Online Printer Management Tool, page 14).

2. Select the Settings tab, then click Fax > Phonebook.

3. For each entry, type a Name and Fax number. Select a Quick Dial as needed.

4. Click Add to update the printer.

5. Select the check box for an existing entry in the Phone Book.

6. Edit or delete the entry as needed.

7. Click Save to update the printer.
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Preparing a fax for transmission 
Before you send a fax, prepare a cover page (if needed), load the original(s), and 
change the resolution and brightness (if needed). 

Printing a fax cover page

If you need a fax cover page, you can print one with your printer, then manually 
complete the information (person to whom you are sending, fax number, your name, 
etc). 

To print a fax cover page:

1. Press Home.

2. Press  to select Fax Settings, then press OK.

3. Press  to select Print Fax Cover page, then press OK.

4. Load letter or A4 paper, then press Start Black or Start Color to begin printing. 

NOTE: It does not matter which Start button you press; the fax cover prints in black 
only. 

Loading originals

To fax documents (up to 25 pages) that are on plain paper, load the original(s) in the 
automatic document feeder (ADF).

To fax a photograph, originals on thick paper, or a document that is too small or too 
large to fit in the ADF, place the original on the scanner glass. (The ADF accepts 
originals from 6.9 x 9.8 in. / 18 x 25 cm to 8.5 x 14 in. / 22 x 36 cm.)

NOTE: You can fax only one page at a time from the scanner glass.

For more information on loading originals, see Loading originals, page 29.
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Changing resolution and brightness 
Before sending your fax, change the resolution and brightness settings, as needed, 
based on your original.

To modify settings before sending your fax:

1. Press Fax.

2. With Fax Options selected, press OK.

3. Press  to select Resolution. 

The resolution setting determines the amount of detail that is transmitted. 
Select:

• Standard (default) for most documents

• Fine for documents with fine print

• Photo for photographs

4. Press  to select Brightness.

Adjust the brightness setting according to how light or dark your original is. 
Select:

• Normal (default) for most documents

• +1 to +3 to lighten dark originals

• -1 to -3 to darken light originals

NOTE: If you do not want to save these settings, send your fax. The settings will 
apply only to the current transmission. If you want to save these settings as 
defaults:

a. Press  to select Save as Defaults, then press OK. 

b. Select Yes, then press OK. 

Sending a fax
You can send your fax in several ways. You can use: 

• the phonebook

• Quick Dial

• the numeric keypad

• the Redial button

Using the phonebook to send a fax

To send a fax to a number in the phonebook: 

1. Press Phonebook. 

2. Press  to select the desired number. 

3. Press Start Black to send a black-and-white fax or Start Color to send a color 
fax. 
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Using Quick Dial to send a fax

To send a fax using Quick Dial: 

1. Press Phonebook. 

2. Press the number on the keypad that corresponds to the desired Quick Dial 
entry. 

3. Press Start Black to send a black-and-white fax or Start Color to send a color 
fax. 

Using the numeric keypad to send a fax

To send a fax from the numeric keypad:

1. Press Fax.

2. Enter a fax number using the numeric keypad.

3. Press Start Black to send a black-and-white fax or Start Color to send a color 
fax.

Using the Redial button to send a fax

To send a fax to one of the last numbers dialed: 

1. Press Redial.
2. Press  to select an entry. 

3. Press Start Black to send a black-and-white fax or Start Color to send a color 
fax.

If there is no number to redial, the phonebook opens.

Receiving a fax
You can set up your printer to receive faxes automatically or manually. Even if your 
printer is set up to receive faxes automatically, you can still receive them manually at 
any time. 

Receiving a fax automatically

To receive faxes automatically: 

1. Load letter (8.5 x 11 in. / 22 x 28 cm) or A4 (8.3 x 11.7 in. / 21 x 30 cm) plain 
paper into the paper tray (see Loading plain paper, page 26). 

2. Make sure the Auto Answer LED is on. (If not, press Auto Answer to turn it on.) 

The printer will receive all incoming faxes automatically.

IMPORTANT: Whenever there is an incoming fax, the printer LCD shows the message, 
“Incoming Call. Press START to Answer.” If the Auto Answer LED is on, you 
do not need to press START to receive the fax. The printer will automatically 
receive the fax after the number of rings that you selected for the fax 
settings (see Rings to Answer, page 65). However, you may choose to 
receive the fax sooner by pressing either START button. (Whether the fax is 
color or black is determined by the sender.) 
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Receiving a fax manually 
If Auto Answer is turned off for your printer, you can receive incoming faxes 
manually. 

NOTE: You can receive any incoming fax manually, even if Auto Answer is 
turned on. 

To receive a fax manually: 

• When you hear the phone ring, press Start Black or Start Color.

NOTE: Pressing either Start button triggers the printer to receive the fax. It does 
not matter which Start button you press; whether a fax is color or black 
and white is determined by the sender. 

If your printer is connected to the same phone line as another telephone and you are 
using tone dialing (see Dialing Mode, page 67), you may receive an incoming fax 
manually from another phone. When you hear the distinctive ring of your fax line or 
know that the incoming call is a fax: 

• Pick up any phone and dial 234 (the remote access code). 

Printing fax reports
You can set up the printer to print certain reports automatically. You can also print 
reports manually at any time. Fax Settings report

Fax settings report

To print the current fax settings: 

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. Press  to select Print Fax Settings, then press OK.

4. Load letter or A4 paper, then press Start Black or Start Color
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Fax confirmation page

The Fax Confirmation Page contains the time and date of transmission, the number 
that you called and the number you called from, and whether the transmission was 
successful. To print the Fax confirmation page, you must select the option to print 
before you transmit the fax. The default setting is to never print the fax confirmation 
page. 

To print the fax confirmation page for future faxes: 

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. Press  to select Print Fax Conf. Page.

4. Press or  to select Always (to print a confirmation page after sending every 
fax) or After Fail Only to print only if the fax transmission fails. 

5. Press OK.

NOTE: The name and fax number of receivers will not appear on your confirmation 
page if the receivers have not set up that information on their fax machines. 

Fax activity log
The Fax Activity Log provides detailed information approximately the last 30 faxes 
sent or received. The log contains the information such as date, time, duration of 
transmission, to/from, and number of pages. 

To print a Fax Activity Log:

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. Press  to select Print Fax Activity Log, then press OK.

4. Load US Letter (8.5 x 11 in.) or A4 paper, the press Start Black or Start Color. 

NOTE: The name and fax number of receivers will not appear on your fax activity 
log if the receivers have not set up that information on their fax machines. 

Canceling a fax
You can cancel a fax that you are sending or receiving at any time. 

To cancel sending or receiving a fax: 

• Press Cancel. 
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8 Maintaining Your Printer
Your printer requires little maintenance. However, Kodak recommends cleaning the 
scanner glass and lid regularly to remove dust and fingerprints, which affect the 
quality and accuracy of scanning.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. 
If you use a power strip, don't turn off the power strip. (The printer does not need to 
be turned on but should be plugged in.)

For optimal performance, keep the printer connected to a computer that is powered 
on, or keep the printer powered on and connected to the Internet through a wireless 
network.

Keep the printhead and ink cartridges in the printer at all times to help prevent 
damage to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, 
go to the Electronics Industry Alliance at www.eia.org or go to 
www.kodak.com/go/recycle. 

General care and cleaning
CAUTION:

Always disconnect the power to the printer before cleaning it. Do not use 
harsh or abrasive cleaners on any part of the printer.

• To clean the printer, wipe the outside with a clean, dry cloth.

• Keep the surrounding area vacuumed and litter-free. 

• To clean the printer, wipe the outside with a clean, dry cloth.

• Protect the printer from tobacco smoke, dust, and liquid spills. 

• Do not place objects on the printer. 

• Keep the input tray free of dust, dirt, and other foreign objects. 

• Keep the printer supplies away from direct sunlight and out of high-temperature 
environments.

• Do not allow chemicals to come into contact with the printer. 
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Cleaning the scanner glass and document backing
The scanner glass can get smudged and minor debris can accumulate on the white 
document backing under the scanner lid. Periodically clean the scanner glass and 
document backing. 

CAUTION:
Do not use harsh or abrasive cleaners on any part of the printer. 
Do not spray liquid directly on the glass.
Do not use paper-based wipes on the document backing as they can 
scratch it.

To clean the scanner glass and document backing under the scanner lid: 

1. Turn off the printer and unplug it from the power outlet. 

2. Lift the scanner lid. 

3. Wipe the glass with a soft cloth or sponge, slightly moistened with a 
nonabrasive glass cleaner. 
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4. Dry the glass with a lint-free cloth.

5. Gently clean the document backing with a soft cloth or sponge, slightly 
moistened with mild soap and warm water. 

6. Dry the document backing with a chamois or lint-free cloth.

NOTE: If the document backing needs further cleaning, use isopropyl (rubbing) 
alcohol on a soft cloth, then wipe thoroughly with a cloth moistened with 
water to remove any residual alcohol. 

7. When you finish cleaning, plug in the printer.
78 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Replacing ink cartridges
Your printer uses both black and color ink cartridges. You can check the approximate 
ink levels on the LCD (see Checking ink levels, page 84) or in Home Center 
Software. When an ink cartridge is out of ink, the printer LCD displays a message 
stating that the black or color ink cartridge needs replacing.

IMPORTANT: Do not use non-Kodak brand or refilled ink cartridges.

To replace an ink cartridge: 

1. Make sure your printer is on.

2. Lift the printer access door, and wait for the carriage to move to a position where 
you can access it. 

The ink cartridges are located in the printhead. 

Black 
ink cartridge

Color ink cartridge

Printhead 
www.kodak.com/go/aiosupport 79



Maintaining Your Printer
3. Pinch the tab on the ink cartridge. 

4. Lift the ink cartridge out of the printhead. 

5. Remove the new ink cartridge from its bag.

IMPORTANT: To prevent the printhead from drying out, insert the ink cartridge into the 
printhead immediately.
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6. Remove the protective cap from the cartridge.

7. Insert the ink cartridge into the printhead.

8. Press down on the ink cartridge tab until you hear a click.

9. Close the printer access door. 
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Updating the software and printer firmware
Using the latest software and firmware helps ensure optimal performance of your 
printer. 

NOTE: Firmware is the software that runs on your printer.

Although there is a background check for software and firmware updates, you may 
update manually using the following procedure. 

Updating manually if your printer is connected to a computer with WINDOWS OS

To update the software:

1. Make sure that your computer is connected to the Internet. 

2. Select Start > All Programs > Kodak > Kodak AiO Printer Tools.

3. Under Printer Resources, click Check for Software Updates to check whether 
software updates are available.

4. If there are updates, click Next and follow the on-screen instructions. 

To update the firmware:

1. Make sure that your computer is connected to the Internet. 

2. Connect the printer to the computer with a USB cable or wirelessly (if not 
currently connected). 

3. Select Start > All Programs > Kodak > Kodak AiO Printer Tools.

4. Make sure that KodakESP2150+xxxx - Connected (or a similar name with 
Connected) appears in the lower left corner of the Printer Tools window.

NOTE: If KodakESP2150+xxxx - Connected does not appear in the lower left corner, 
click Select, then click Refresh List and choose your printer from the list; click 
Install KODAK Printer and follow the on-screen instructions. 

5. Under Printer Resources, click Check for Printer (Firmware) Updates.

6. If there are updates, click Next and follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. 
Doing so may cause the printer to become inoperable. If the printer is 
connected wirelessly, make sure you have a stable connection when you 
perform the update. 
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Updating manually if your printer is connected to a computer with MAC OS
To update the software:

1. Make sure that your computer is connected to the Internet. 

2. Open Home Center Software.

3. Select the Tools tab.

4. Click Check for Software Updates.

5. If there are software updates, follow the on-screen instructions for updating 
your software.

To update the firmware:

1. Make sure that your computer is connected to the Internet. 

2. Connect the printer to the computer with a USB cable or wirelessly (if not 
currently connected). 

3. Open Home Center Software. 

4. Select the Tools tab.

5. Click Check for Printer (Firmware) Updates.

6. If there are updates, follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. 
Doing so may cause the printer to become inoperable. 
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Monitoring and adjusting printer performance
From the control panel, you can perform tasks to help keep the printer functioning 
well.

Checking ink levels

To check the ink levels: 

1. Press Home.

2. Press  to select Maintenance, then press OK.

3. With Check Ink Levels selected, press OK.

The LCD shows approximate levels of ink in the cartridges so you know when it’s 
time to order replacement cartridges. 

NOTE: You can order ink cartridges online. Open Home Center Software and 
select Order Supplies. 

Resetting factory defaults
To reset defaults to the factory default settings: 

1. Press Home.

2. Press  to select Printer Settings, then press OK.

3. Press  to select Reset All Settings, then press OK. 

4. When you see the message, “This will reset printer settings to factory defaults,” 
press OK.

NOTE: Resetting factory defaults does not change the date and time, language, 
country/region, or network settings.
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Replacing the printhead
IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace 

the printhead only if you receive a new printhead from Kodak.

To replace the printhead:

1. Make sure your printer is on.

2. Lift the printer access door, and wait for the carriage to move to the access 
position.

3. Remove both ink cartridges and set them aside. 
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4. Unlatch the used printhead by lifting the button in the center of the carriage.

5. Lift the used printhead out of the carriage.

6. Remove the new printhead from its bag.

CAUTION:
Do not touch the copper contacts on the printhead, as doing so may damage 
the printhead.
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7. Remove the plastic protective cap.

IMPORTANT: Be careful not to scratch or touch the copper contacts while inserting 
the printhead. 

8. Place the new printhead into the carriage.

9. Push firmly against the target label of the printhead until you hear a loud snap.

Copper contacts
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10. Insert the black ink cartridge into the printhead. 

11. Press down on the ink cartridge until you hear it click into position.

12. Repeat steps 10 - 11 for the color ink cartridge. 

13. Close the printer access door. 

The printer detects the new printhead. Follow the instructions on the LCD to 
calibrate your printer. 
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9 Troubleshooting

Basic troubleshooting
Some problems can be resolved quickly by power cycling the printer: Turn off your 
printer. Wait five seconds. Turn on the printer. 

Use the following information to help troubleshoot problems with your printer.

Problem Possible Solutions

Printer does not 
power on

• Make sure you are using the power cord that came with your printer. 
• Make sure that the power cord is connected to the AC adapter and is plugged into 

an outlet or power strip, and that the LED on the AC adapter is lit.
• Make sure that the power cord is securely connected to the power cord port in the 

back of the printer.

Printer not detected • Make sure that your printer is plugged in and turned on.
• If you are using a USB cable, make sure that: 

– it is a USB 2.0 high-speed cable.
– it is connected to both your printer and your computer.
– you restart the computer if the USB cable was disconnected from the printer 

then reconnected, or if power to the printer was interrupted.
• If you are using a wireless connection, make sure:

– the Wi-Fi connectivity LED is glowing steadily.
– the printer is connected to your wireless network.

To check:
a. On the printer, press Home.
b. Press  to select Network Settings, then press OK.
c. Press  to select View Network Configuration, then press OK. 

Make sure that the Active Connection Type is WiFi, and that the IP Address is 
not zeros. 

– your router is transmitting data.
– the firewall (excluding WINDOWS Firewall) is allowing the services needed for 

your printer.

For additional information, go to www.kodak.com/go/inkjetnetworking.

Wireless connectivity For wireless connectivity issues, go to www.kodak.com/go/inkjetnetworking.

Carriage jam • Open the printer access door and clear any obstructions.
• Check that the printhead and ink cartridges are installed correctly. 

(The printhead and ink cartridges are installed correctly when you hear them click 
into place.)

Ink cartridge errors • Check that KODAK Ink Cartridge(s) are installed. Do not use non-Kodak brand or 
refilled ink cartridges. 

• Remove, then install the cartridges again. Make sure the cartridges click into place.
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Too much paper curl 
after printing

• If your are printing pictures or documents with large areas of image content, try 
increasing the top and bottom margins when printing in portrait mode or the left 
and right margins when printing in landscape mode. Start with a one-inch margin on 
top and bottom and a quarter-inch margin on the sides. The larger the margin, the 
less potential there is for curl.

• Print on a higher weight paper, such as 24 lb (90 gsm) paper or print on KODAK 
Ultimate Paper.

• Apply a border, rather than printing in borderless mode.
• If the paper is not stacking properly in the output tray, remove the pages as they 

exit.

Print quality • For best results, use KODAK Paper or a paper with the COLORLOK Technology logo 
on the package.

• Make sure the paper is loaded correctly. See Loading plain paper, page 26 and 
Loading photo paper, page 27.

• Clean the printhead:

– Press Home.
– Press  to select Maintenance, then press OK.
– Press  to select Clean Printhead, then press OK.

• Calibrate the printer:

– Press Home.
– Press  to select Maintenance, then press OK.
– Press  to select Calibrate Printer, then press OK.

For more information, go to www.kodak.com/go/aiosupport, then type the problem in 
the search field.

Paper jam • Open the access door and gently pull paper out from the front, reaching through the 
opening above the paper output tray.

• If you cannot access the paper from the front, gently pull the jammed paper up from 
the paper input tray.

• Make sure the paper in the input tray is free of tears or creases.
• Make sure you do not overload the paper input tray.
For more information, go to www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support, then type Paper jam in the search field.

Problem Possible Solutions
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Getting help on the Web
For more troubleshooting information:

Cannot send or receive 
a fax

• Make sure that the wall phone line is plugged into the Line in port. 
• Verify that the wall jack works by plugging in a phone and checking for a dial tone.
• Verify that Region is set to the correct country code. 

– Press Home.
– Press  or  to select Printer Settings, then press OK.
– Press  to select Country/Region, then press OK.
– Press  or  to select your country, then press OK.

• If you are connected to a DSL phone line, make sure you have a DSL filter connected 
to the phone jack. 

For more information, go to www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support, then type Fax in the search field. 

Error codes/messages • Go to www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support, then type your error code or message.

Problem Possible Solutions

Get help with wireless networking. www.kodak.com/go/inkjetnetworking

Search our knowledge base of Questions and 
Answers.

www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support

Download the latest firmware and software for 
optimal printer performance.

www.kodak.com/go/esp2150downloads or 
www.kodak.com/go/esp2170downloads

Check the Extended User Guide for detailed 
instructions and the recommended system 
requirements

www.kodak.com/go/aiomanuals

Get help with problems you cannot resolve. Contact Kodak at www.kodak.com/go/contact and have the 
following information available: 
– KODAK Service Number (located inside the printer when 

you open the printer access door)
– Printer model number (located on the control panel above 

the LCD)
– Computer model, operating system, and version of Home 

Center Software
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Status lights
There are three status lights on the printer: the power status light (on the on/off 
button) indicates power, the Wi-Fi status light indicates Wi-Fi status, and the 
attention light blinks when an error occurs.

Power light

Wi-Fi connectivity LED 

Power light What it means

Off • The printer is turned off.

– Press the power button to turn on power.

• The printer does not have power.

– Make sure that the power cord is plugged into the 
back of the printer and into an electrical outlet, and 
that the electrical outlet has power.

Blinking • The printer is busy.

– Wait for the printer to finish the task.

On The printer is ready.

Wi-Fi connectivity LED What it means

Off The Wi-Fi radio is either turned off or is turned on but not 
connected to a wireless network.

Blinks continuously The Wi-Fi radio is turned on, and the printer is searching for 
available wireless networks within range.

Blinks intermittently The Wi-Fi radio is turned on and the printer cannot find any 
available wireless networks within range, or the Wi-Fi radio 
connection has been interrupted, or is too weak to send 
signals to and from the printer.

To find and connect to an available wireless network within 
range, press OK, turn the Wi-Fi radio off, and run the Wi-Fi 
Setup Wizard (see Connecting to a wireless network, 
page 15).

On The Wi-Fi radio is turned on, and there is a working 
connection between the printer and a wireless network.
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10 Product and Safety Specifications
The following specifications are subject to change without notice.

Features and Specifications

Print performance

Photo printing features

Black print speed 6 images per minute 

Color print speed 4 images per minute 

Print technology Continuous-tone, thermal inkjet

Print quality modes Draft, Normal, and Best on plain paper

Photo quality mode on photo paper

Quantity 1 to 99 

Print sizes 2 x 3 in. / 5 x 8 cm
3.5 x 5 in. / 9 x 13 cm
4 x 6 in. / 10 x 15 cm
4 x 7 in. / 10 x 18 cm
4 x 8 in. / 10 x 20 cm
4 x 12 in. / 10 x 30 cm (Panoramic) 

5 x 7 in. / 13 x 18 cm
8 x 10 in. / 20 x 25 cm
US Letter - 8.5 x 11 in. / 22 x 28 cm
A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Best, Normal, Draft modes on plain paper

Photo quality mode on photo paper 

Auto-detect media Auto-detect plain paper and photo papers

Optimize image quality for KODAK Photo Papers with barcode

Image enhancement KODAK PERFECT TOUCH Technology with 
Home Center Software (from the computer only)

Color Black-and-white or color

Scene balance On (default), Off 
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Copy document features

Copy photo features

Scanning features

Color Black-and-white or color

Quantity 1 to 99 copies 

Copy sizes Same Size, Fit to Page, 20% to 500% 

Plain paper quality Best, Normal, Draft

Brightness – 3 to + 3

Color Black-and-white or color

Quantity 1 to 99 

Copy sizes 2 x 3 in. / 5 x 8 cm
3.5 x 5 in. / 9 x 13 cm
4 x 6 in. / 10 x 15 cm
4 x 7 in. / 10 x 18 cm
4 x 8 in. / 10 x 20 cm
4 x 12 in. / 10 x 30 cm (Panoramic) 

5 x 7 in. / 13 x 18 cm
8 x 10 in. / 20 x 25 cm
US Letter - 8.5 x 11 in. / 22 x 28 cm
A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Automatic

Brightness – 3 to + 3

Scanner type Contact Image Sensor (CIS)

Scan sizes Maximum size of original scanned from platen: 
8.5in. / 22 cm wide; 11.7 in. / 30 cm long 

Sizes of originals scanned from ADF:

B5 (6.9 x 9.8 in. / 18 x 25 cm)
US Executive (7.3 x 10.5 in. / 18 x 27 cm)
US Letter (8.5 x 11 in. / 22 x 28 cm)
A4 (8.3 x 11.7 in. / 21 x 30 cm)
US Legal (8.5 x 14 in. / 22 x 36 cm) 

Functions Segmentation scanning

Auto-destination

Optical Character Recognition (OCR) 
94 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Faxing features and specifications

Paper input tray 

Automatic Document Feeder (ADF) for originals

Ink cartridges

Connectivity

Fax transfer rate 9600, 14400, or 33600 (default) baud 

Fax memory 100 pages at 96 dpi text

Speed dials Up to 60

Resolution Standard: 200 x 100
Fine: 200 x 200
Photo: 300 x 300

Paper capacity 150 sheets of 20 lb plain paper

20 sheets of photo paper, up to 12 mil (290 gsm)

20 envelopes

Tray size 4 x 6 in. to 8.5 x 14 in. / 10 x 15 cm to 22 x 36 cm 

Paper capacity 25 sheets (20 to 24 lb / 75 to 90 gsm) plain paper

Paper size limits 6.9 x 9.8 in. to 8.5 x 14 in. / 18 x 25 cm to 22 x 36 cm

Ink handling 2-cartridge, 4-ink system

Ink life 1-year warranty from date of purchase

Protocols supported USB 2.0 High Speed; DPOF

Devices supported WINDOWS OS-based and MACINTOSH Computers, memory 
cards (SD, MS/Duo, MMC, SDHC)

Image formats supported Image printing supports JPEG (EXIF v2.21 non-progressive); 
does not support progressive JPEG format; image scanning 
supports scanning to JPG and non-searchable PDF

Number of USB ports One USB 2.0 high-speed device port on the back of the printer

Wi-Fi technology
supported

802.11b/g/n, WPA/WPA2, WPS, and WEP
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Software support

Physical specifications

Warranty

Application support Third-party image-management software; optical character 
reader (OCR) support for documents

Media support Plain paper, photo paper, envelopes, greeting cards, card stock, 
and labels

Scanner support TWAIN and WIA, WIA2 (WINDOWS 7 and VISTA OS), ICA 
(MAC OS) and TWAIN (on MAC OS 10.4 and 10.5), including 
segmentation scanning

Update support Software and firmware updates available through Web support

Power Input: 110–240 V AC, 50–60 Hz 
Output: 36 V DC at 1.6 A

Storage dimensions 45.5 cm (17.9 in.) wide x 41.5 cm (16.3 in.) deep x 23.0 cm
(9.1 in.) tall with input and output trays closed

Operating dimensions 45.5 cm (17.9 in.) wide x 65.0 cm (25.6 in.) deep x 29.6 cm
(11.7 in.) tall with input and output trays fully extended for
operation

Weight 6.9 kg (15.2 lb) without power supply, printhead, or ink
cartridges

Operating range 5°C (41°F) to 35°C (95°F), 15 to 85% RH

Full image quality
environmental range

15°C (59°F) to 30°C (86°F), and 20 to 80% RH

Energy efficiency ENERGY STAR® Qualified 

Product One year from purchase (with proof of purchase)

Printhead One year from purchase (with proof of purchase)
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Minimum System requirements

Computer with WINDOWS OS

Computer with MAC OS

Computer Minimum

Operating System WINDOWS 7, VISTA, or XP (SP2 or later)

CPU INTEL CELERON Processor

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 500 MB available

Interface USB 2.0 cable 

CD drive CD-ROM

Computer Minimum

Operating System MACINTOSH OS X 10.4.8 or later

CPU PowerPC G4, G5, or INTEL-based MAC

Clock speed 1.2 GHz

Memory 512 MB RAM 

Available hard disk space 200 MB available

Interface USB 2.0 cable

CD drive CD-ROM
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Paper types supported

Paper sizes supported

Plain paper 16 to 24 lb (60 to 90 gsm)

Photo paper 6.5 to 12 mil 

Card stock 110 lb index max (200 gsm)

Envelopes 20 to 24 lb (75 to 90 gsm)

Transparencies All commercially available inkjet varieties (with a white strip 
on the long edge) - 8.5 x 11 in. and A4 size

Labels All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets

Iron-on transfers All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets

Plain paper A4 (8.3 x 11.7 in. / 21 x 30 cm)

A5 (5.8 x 8.3 in. / 15 x 21 cm)

A6 (4.1 x 5.8 in. / 11 x 15 cm)

B5 (6.9 x 9.8 in. / 18 x 25 cm)

US Executive (7.3 x 10.5 in. / 18 x 27 cm) 

US Letter (8.5 x 11 in. / 22 x 28 cm)

US Legal (8.5 x 14 in. / 22 x 36 cm)

Custom sizes from 4–8.5 in. / 10–22 cm wide and 6–14 in. / 
15–36 cm long

Labels A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

Index card stock 4 x 6 in. index cards (10 x 15 cm)

5 x 7 in. index cards (13 x 18 cm)

Iron-on transfers A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in.) (22 x 28 cm)

Envelopes C5 (6.4 x 9 in. / 16 x 23 cm)

C6 (4.5 x 6.4 in. / 11 x 16 cm)

DL (designated long) (4.3 x 8.7 in. / 11 x 22 cm)

US #10 (4.1 x 9.5 in / 11 x 24 cm)

US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

US #9 (3.9 x 8.9 in. / 10 x 23 cm)
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Photos 4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 31 cm

5 x 7 in. / 13 x 18 cm

7 x 10 in. / 18 x 25 cm

8 x 10 in. / 20 x 25 cm

US Letter (8.5 x 11 in. / 22 x 28 cm)

A4 (8.3 x 11.7 in. / 21 x 30 cm)
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Product and Safety Specifications
Safety information
KODAK ESP Office 2100 Series All-in-One Printers are Class 1 LED Products.

• Always follow all warnings and instructions marked on the product.

• Use only the power source indicated on the product regulatory label.

• Use only the power cord that comes with the product (or an approved power 
cord greater than or equal to H05W-F, 3G, 0.75 mm2). Using another power 
cord may cause fire and/or shock. Do not use the included power cord with any 
other equipment. 

• Always turn this product off by using the On/Off button. Wait until the On/Off 
button stops flashing before removing the power plug from the outlet. 

• Do not allow the power cord to become damaged or frayed.

• If you need to use an extension cord with this product, make sure that the 
ampere rating of the product does not exceed the ampere rating of the extension 
cord.

• Place the product on a flat, stable surface that extends beyond the product’s 
base in all directions. This product will not operate properly if tilted or at an 
angle.

• When storing or transporting this product, do not tilt or stand it on its side. 
Never turn this product upside down (ink can leak out of the product).

• Avoid placing this product in an environment that is subject to rapid changes in 
temperature or humidity, mechanical shocks, vibration, or dust. Do not place 
near radiators, heating vents, or in direct sunlight.

• Leave enough room around this product for sufficient ventilation. 

• Do not block this product’s covers or openings, or insert any objects through 
slots. 

• Do not use aerosol products inside or around this product.

• Do not spill any liquid on this product.

• Do not attempt to repair or service this product.

• If the power cord or plug is damaged, if any liquid has been spilled onto the 
product, if the product has been dropped or the case damaged, if the product 
does not operate normally or exhibits a major change in performance level, 
unplug this product and contact Kodak at www.kodak.com/go/contact.

For Service Personnel:

CAUTION:
Risk of explosion if battery is replaced by an incorrect type. Dispose of used 
batteries according to local instructions.
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LCD screen safety

• Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or 
chemical cleaners.

• If the LCD screen is damaged, contact Kodak immediately. If any of the solution 
from the display gets on your hands, wash them thoroughly with soap and water. 

Ink cartridge safety

• Keep all ink cartridges out of the reach of children.

• If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush 
immediately with water. If any discomfort or change in vision persists after 
washing, seek medical attention immediately.

• For MSDS information on inks, go to www.kodak.com/go/MSDS.

Regulatory compliance

FCC statement

The United States Federal Communications Commission (in CFR 47 Part 15.105) has 
specified that the following notice be brought to the attention of the users of this 
product:

NOTE: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver

• Connect the product into an outlet on a circuit different from that to which 
the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.
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CAUTION:
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this 
product not expressly approved by Eastman Kodak Company might cause 
harmful interference and void the FCC authorization to operate this product.

The radiated energy from this product is well below the FCC radio frequency 
exposure limits. Nevertheless, the product shall be used in such a manner 
that the potential for human contact during normal operation is minimized. 
This product and any attached external antenna, if supported, shall be placed 
in such a manner to minimize the potential for human contact during normal 
operation. In order to avoid the possibility of exceeding the FCC exposure 
limits, human proximity shall not be less than 20 cm (8 inches) during normal 
operation.

Canadian statements

This product meets the applicable Industry Canada technical specifications.

Operation is subject to the following two conditions: (1) this device may not cause 
interference, and (2) this device must accept any interference, including interference 
that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.

Industry Canada (IC) Radiation Exposure Statement

This equipment complies with IC radiation exposure limits set forth for an 
uncontrolled environment. This equipment should be installed and operated with a 
minimum distance of 20 cm between the radiator and your person.

European compliance statement

Hereby, Eastman Kodak Company declares that this KODAK all-in-one wireless 
printer is in compliance with the essential requirements and other relevant 
provisions of Directive 1999/5/EC.

German compliance statement 

Noise emissions for this equipment do not exceed 70 dB(A).

This equipment is not intended for use in the work place in accordance with 
BildscharbV regulations.

“Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß 
BildscharbV vorgesehen.” 
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REACH Article 33 declarations

Go to www.kodak.com/go/REACH for information about the presence of 
substances included on the candidate list according to article 59(1) of Regulation 
(EC) No. 1907/2006 (REACH).

Power supply information

Certified External Power Supply that can be used with this product: Hipro 
HP-A0601R3, or Flextronics VP-09500084-000.

Waste electrical and electronic equipment labeling

In the European Union, do not discard this product as unsorted municipal waste. 
Contact your local authorities or go to www.kodak.com/go/recycle for recycling 
program information.

ENERGY STAR® Qualified
To conserve energy, this printer will enter a reduced power (sleep) mode 
automatically after 1 hour. You can adjust the delay time (in 0.5 hour increments) up 
to 4 hours. Increasing the delay time may result in reduced energy savings.

ENERGY STAR and the ENERGY STAR mark are registered U.S. service marks. As an 
ENERGY STAR partner, Kodak has determined that this product meets ENERGY 
STAR Guidelines for energy efficiency. For more information on the ENERGY STAR 
program, see www.energystar.gov. 

Warranty Information
Limited Warranty

Kodak warrants Kodak consumer electronic products and accessories (“Products”), 
excluding batteries, to be free from malfunctions and defects in both materials and 
workmanship for one year from the date of purchase. Retain the original dated sales 
receipt. Proof of the date of purchase will be required with any request for warranty 
repair.

 

www.kodak.com/go/aiosupport 103

http://www.kodak.com/go/reach
http://www.energystar.gov


Product and Safety Specifications
Limited Warranty Coverage

Warranty service is only available from within the country where the Products were 
originally purchased. You may be required to send Products, at your expense, to the 
authorized service facility for the country where the Products were purchased. 
Kodak will repair or replace Products if they fail to function properly during the 
warranty period, subject to any conditions and/or limitations stated herein. 
Warranty service will include all labor as well as any necessary adjustments and/or 
replacement parts. If Kodak is unable to repair or replace a Product, Kodak will, at its 
option, refund the purchase price paid for the Product provided the Product has been 
returned to Kodak together with proof of the purchase price paid. Repair, 
replacement, or refund of the purchase price are the sole remedies under this 
warranty. If replacement parts are used in making repairs, those parts may be 
remanufactured or may contain remanufactured materials. If it is necessary to 
replace the entire Product, it may be replaced with a remanufactured Product. 
Remanufactured Products, parts and materials are warranted for the remaining 
warranty term of the original Product, or 90 days after the date of repair or 
replacement, whichever is longer.

Limitations

This warranty does not cover circumstances beyond Kodak’s control. This warranty 
does not apply when failure is due to shipping damage, accident, alteration, 
modification, unauthorized service, misuse, abuse, use with incompatible 
accessories or attachments (such as third party ink or ink tanks), failure to follow 
Kodak’s operation, maintenance or repacking instructions, failure to use items 
supplied by Kodak (such as adapters and cables), or claims made after the duration 
of this warranty. KODAK MAKES NO OTHER EXPRESS OR IMPLIED WARRANTY 
FOR THIS PRODUCT, AND DISCLAIMS THE IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. In the event that the exclusion of any implied warranty is ineffective 
under the law, the duration of the implied warranty will be one year from the 
purchase date or such longer period as required by law. The option of repair, 
replacement, or refund is Kodak’s only obligation. Kodak will not be responsible for 
any special, consequential or incidental damages resulting from the sale, purchase, 
or use of this product regardless of the cause. Liability for any special consequential 
or incidental damages (including but not limited to loss of revenue or profit, 
downtime costs, loss of the use of the equipment, cost of substitute equipment, 
facilities or services or claims of your customers for such damages resulting from 
the purchase, use or failure of the Product), regardless of cause, or for breach of any 
written or implied warranty is expressly disclaimed.

Your Rights

Some states or jurisdictions do not allow exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 
Some states or jurisdictions do not allow limitations on how long an implied 
warranty lasts, so the above limitation may not apply to you. This warranty gives you 
specific rights, and you may have other rights which vary from state to state or by 
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jurisdiction. Your statutory rights are not affected.

Outside the United States and Canada

In countries other than the United States and Canada, the terms and conditions of 
this warranty may be different. Unless a specific Kodak warranty is communicated to 
the purchaser in writing by a Kodak company, no warranty or liability exists beyond 
any minimum requirements imposed by law, even though defect, damage, or loss 
may be by negligence or other act.

Declaration of Conformity
See www.kodak.com/go/declarationofconformity. 
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A
access door, location, 9
ADF (automatic document feeder)

loading, 30
location, 9

ADF paper-edge guides, location, 9
Apple Macintosh  See Macintosh
attention light

location, 10
auto answer button, location, 10
auto answer LED, location, 10
auto answer, setting for faxing, 68

B
back button, location, 10
black-and-white

copies, 43, 46
fax, sending, 72
scanning, 59

C
call waiting, disabling, 66
cancel button, location, 10
card slot, location, 9
cleaning

document backing, 77
printer, 76
scanner glass, 77

color
copies, 43, 46
fax, sending, 72
scanning, 59

components, 9
computer requirements, 97
configuring printer settings, 12
connecting to a wireless network, 15—22

additional printer, 21
from USB, 22—23
printer on additional computers, 21

control panel
location, 9
numeric keypad, 70

copy mode button, location, 10
copying, 42—47

documents, 42—44
adjusting settings, 42—43
black-and-white, 43
brightness, 43, 44
color, 43
copy sizes, 94
darkening, 43, 44
enlarging, 43, 44
features, 94

fit to page, 43
lightening, 43, 44
number of copies, 43, 44
quality, 43
quantity, 43, 44
reducing, 43, 44
using default settings, 42

loading originals, 42
photos, 45—47

adjusting settings, 45—46
black-and-white, 46
brightness, 46, 47
color, 46
copy sizes, 94
darkening, 46, 47
enlarging, 45, 47
features, 94
lightening, 46, 47
number of copies, 45, 47
previewing on LCD, 46
quality, 46
quantity, 45, 47
reducing, 45, 47
sizes, 45
using default settings, 45

country/region, setting, 12
cover page, fax, 71

D
darkening copies

documents, 43, 44
photos, 46, 47

date and time, setting, 12
declaration of conformity, 105
defaults

resetting, 12, 84
save copy settings as

documents, 43
photos, 46

save scan settings as, 59
defaults, printing photos, 38
distinctive ring, 66
document backing, cleaning, 77
documents

paper sizes, 98
printing, 31—32
printing two-sided, 31—32

downloading (updating)
printer firmware, 82—83
software, 82—83

DPOF, 40
DPOF (digital print order format) printing

See tagged images, printing
duplexing, 31—32
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E
ENERGY STAR qualification, 103
energy-saving sleep mode, 12
enlarging copies

documents, 43, 44
photos, 45, 47

envelopes
capacity, 28
loading, 28
sizes, 25, 98

F
fax mode button, location, 10
faxing, 60—74

activity log, 67
answering machine setup, 63
answering service setup, 64
brightness and resolution, 72
call waiting

disable code, 66
disabling, 66

confirmation page, 66
cover page, 67, 71
darkening, 72
dedicated phone line setup, 63
dialing mode

pulse, 67
tone, 67

distinctive ring, 66
error correction mode, 67
header information, entering, 64
lightening, 72
loading originals, 71
phonebook, 68

adding entries, 69
deleting entries, 70
editing entries, 69

preparing transmission, 71
printing fax settings, 67
receiving, 73—74

automatically, 73
manually, 74

resolution and brightness, 72
rings to answer, 65
sender information, entering, 64
sending, 72—73

using numeric keypad, 73
using phonebook, 72
using quick dial, 73
using redial button, 73

set up, 60
setting answer mode, 68
setting options, 65—67

shared phone line setup, 63
finding photos, 34, 38
firmware, downloading (updating), 82—83

G
glass, scanner

cleaning, 77
location, 9

graph paper, printing, 33
grocery list, printing, 33

H
home button, location, 10
Home Center Software, 11, 48, 50, 56, 83
hostname, printer, 20

I
Image Capture software, 41
image formats supported, 95
index card stock, sizes, 98
ink cartridges, replacing, 79—81
ink levels, 84
IP address

setting up, 19
viewing, 20

iPhoto software, 41
iron-on transfers, sizes, 24, 98

K
keyboard on LCD, using, 16
KODAK All-in-One Printer Software, 11
KODAK Home Center Software

See Home Center Software
KODAK Pic Flick App, 40

L
label sizes, 98
language, setting, 12
LCD screen, location, 10
lightening copies

documents, 43, 44
photos, 46, 47

loading originals
for copying, 42
for faxing, 71
for scanning, 55
on scanner glass, 29
using ADF, 30

loading paper input tray
envelopes, 28
photo paper, 27
plain paper, 26
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M
MAC address, viewing, 20
media supported, 98
memory card slot, location, 9
memory cards, printing from, 35

N
narrow-ruled paper, printing, 33
navigation buttons, location, 10
network, wireless

See wireless network
numeric keypad on control panel, using, 70
numeric keypad, location, 10

O
OK button, location, 10
Online Printer Management Tool, 13—14

accessing, 14
using to configure printer settings, 14

originals, loading
for copying, 42
for faxing, 71
for scanning, 55
on scanner glass, 29
using ADF, 30

output tray extender, location, 9

P
panoramic pictures, printing, 39
paper, 24—30

loading input tray
envelopes, 28
photo paper, 27
plain paper, 26

sizes, 98
sizes supported, 24
types, 98
types supported, 24

paper input tray
capacity

envelopes, 28
photo paper, 27
plain paper, 26

location, 9
paper output tray, location, 9
paper tray

capacity, 95
paper-edge guides, location, 9
phone port, location, 9
phonebook

adding new entries, 69
deleting entries, 70
editing entries, 69

phonebook button, location, 10

photo mode button, location, 10
photo paper

capacity, 27
loading, 27

photo paper sizes, 99
photo printing

image enhancement, 93
print sizes, 93
quality, 93
scene balance, 93

photos
finding, 34
printing, 33—40
viewing, 34

Pic Flick App, 40
pictures

printing, 33—40
DPOF, 40
tagged, 40

transferring to computer, 41
plain paper

capacity, 26
loading, 26

ports
phone line for faxing, 9
USB, 9

power button, location, 10
power cord connection port, location, 9
printer

cleaning instructions, 76
defaults, resetting, 12, 84
hostname, 20
maintaining, 76—88
settings, configuring, 12
supplies

recycling, 76
printer connection, changing USB to wireless, 22
printhead

removing, 86
replacing, 85—88

printhead, location, 9
printing, 31—41

documents, 31—32
two-sided, 31—32

forms, 33
pictures, 33—40

DPOF, 40
from memory card, 35
from USB-connected device, 35
panoramic, 39
tagged, 40
tagged images, 12

speed, 93
two-sided documents, 31—32
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Q
quick dial, 69

R
receiving fax, 73—74

automatically, 73
manually, 74

recycling printer or supplies, 76
redial button, location, 10
reducing copies

documents, 43, 44
photos, 45, 47

regulatory compliance, 101
Canadian, 102
European, 102
German, 102
REACH Article 33 declarations, 103
waste labeling, European Union, 103

reminder list, printing, 33
replacing

ink cartridges, 79—81
printhead, 85—88

resolution, scanning, 49, 50
rings to answer, 65

S
safety information, 100—101
scan mode button location, 10
scanner glass

cleaning, 77
location, 9

scanner lid, location, 9
scanner type, 94
scanning, 48—59

automatically detect pictures, 50
features, 94
file format

document, 49
picture, 50

from computer, 56
from control panel, 57—59
from Online Printer Management Tool, 59
loading originals, 55
multiple pictures simultaneously, 56
resolution, 49, 50
selecting quality, 50
setting options, 58—59

Service Set Identifier, 15
setting options, 37—38
settings

copy documents, 42—43
copy photos, 45—46
fax, 65—67

printing
photos, 37—38

scanning, 58—59
sheet music, printing, 33
sleep mode, 12
software

downloading (updating), 82—83
support, 96

specifications, 93—99
physical dimensions, 96
power, 96
weight, 96

SSID, 15
Start black button, location, 10
Start color button, location, 10
supplies, ordering, 12
system requirements, minimum, 97—99

T
telephone service

cable, 60
digital subscriber line (DSL), 60, 61
Internet (VOIP), 60
standard, 60

tic-tac-toe, printing, 33
time and date, setting, 12
time to low power, setting, 12
transferring pictures to computer, 41
transparencies, 24
tray, paper input, capacity

envelopes, 28
photo paper, 27
plain paper, 26

troubleshooting, 89—92
two-sided printing, 31—32

U
updating

firmware, 82—83
software, 82—83

USB connection, changing to wireless, 22—23
USB ports

location, 9
USB-connected device, printing from, 35

V
viewing photos, 34

W
warranty, 96, 103—105

ink, 95
Web support

contact information, 100
www.kodak.com/go/aiosupport 109
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ENERGY STAR program, 103
iPhone, iPad, and iPod Touch devices, 33, 40
Material Safety Data Sheets (MSDS), 101
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Pic Flick App, 33, 40
REACH Article 33 declarations, 103
recycling, 76

wide-ruled paper, printing, 33
Wi-Fi

technology supported, 95
Wi-Fi connectivity LED, location, 10
Wi-Fi Setup wizard, 15
wireless network

configuration, viewing and printing, 20
connecting to, 15—22

additional KODAK All-in-One Printer(s), 21
from USB, 22
non-WPS router, 15
printer on additional computers, 21
using Wi-Fi Setup wizard, 15
WPS router, 17

IP address, setting up, 19
settings, configuring, 15
subnet, viewing, 20

WPS, 15
WPS router, 17
110 www.kodak.com/go/aiosupport


	Printer Overview
	Components
	Control panel
	Home Center Software
	Ordering supplies
	Configuring printer settings
	Online Printer Management Tool
	Accessing the Online Printer Management Tool
	Using the Online Printer Management Tool to configure your printer’s settings


	Networking Your Printer
	Connecting to a wireless network
	Before you connect
	Connecting to a wireless network using the Wi-Fi Setup Wizard
	Connecting to a non-WPS wireless router
	Connecting to a WPS wireless router

	Setting up an IP address
	Viewing the network configuration
	Printing the network configuration
	Changing the printer name
	Installing your printer on additional computers on the network
	Connecting to another KODAK All-in-One Printer

	Adding a wireless network connection to a USB-connected computer
	Changing from USB to a wireless connection


	Handling Paper
	Paper types
	Paper sizes
	Envelope sizes
	Loading paper
	Loading plain paper
	Loading photo paper
	Loading envelopes

	Loading originals
	Using the scanner glass
	Using the Automatic Document Feeder (ADF)


	Printing
	Printing documents
	Printing two-sided documents
	Printing forms

	Printing pictures
	Viewing pictures on a memory card or USB-connected device
	Finding pictures on a memory card or USB-connected device

	Printing from a memory card or USB-connected device
	Using default settings to print a picture
	Changing the settings and printing pictures
	Printing panoramic pictures
	Printing tagged pictures


	Printing from a wireless device
	Transferring pictures to a computer
	Transferring pictures to a computer with WINDOWS OS
	Transferring pictures to a computer with MAC OS


	Copying
	Loading originals for copying
	Copying a document
	Using the default settings to copy a document
	Adjusting the settings and copying a document
	Changing the number of copies of a document
	Enlarging or reducing a document
	Darkening or lightening a copy

	Copying a photograph
	Using the default settings to copy a photograph
	Adjusting the settings and copying a photograph
	Changing the number of copies of a photograph
	Enlarging or reducing a photograph
	Darkening or lightening a copy of a photograph


	Scanning
	Before you begin scanning
	Changing the scan settings for scanning from the printer control panel
	Adding a profile and address book for Scan To Email
	Adding a profile for Scan To Network Folder

	Loading originals for scanning
	Scanning from the computer
	Scanning multiple pictures simultaneously
	Scanning multiple pictures when connected to a computer with WINDOWS OS
	Scanning multiple pictures when connected to a computer with MAC OS


	Scanning from the control panel
	Scanning from the Online Printer Management Tool

	Faxing
	Before you begin faxing
	Connecting the printer for faxing
	Selecting the country/region
	Determining your telephone system type
	Determining whether your phone line is dedicated or shared

	Entering fax sender information
	Setting fax options
	Setting the answer mode (auto answer or manual)

	Working with the phonebook
	Using symbols in phonebook entries
	Adding a new phonebook entry
	Editing a phonebook entry
	Deleting a phonebook entry
	Using the numeric keypad on the control panel to enter text and/or numbers
	Using the Online Printer Management Tool to edit the Fax Phone Book


	Preparing a fax for transmission
	Printing a fax cover page
	Loading originals
	Changing resolution and brightness

	Sending a fax
	Using the phonebook to send a fax
	Using Quick Dial to send a fax
	Using the numeric keypad to send a fax
	Using the Redial button to send a fax

	Receiving a fax
	Receiving a fax automatically
	Receiving a fax manually

	Printing fax reports
	Fax settings report
	Fax confirmation page
	Fax activity log

	Canceling a fax

	Maintaining Your Printer
	General care and cleaning
	Cleaning the scanner glass and document backing

	Replacing ink cartridges
	Updating the software and printer firmware
	Updating manually if your printer is connected to a computer with WINDOWS OS
	Updating manually if your printer is connected to a computer with MAC OS

	Monitoring and adjusting printer performance
	Checking ink levels
	Resetting factory defaults

	Replacing the printhead

	Troubleshooting
	Basic troubleshooting
	Getting help on the Web
	Status lights
	Power light
	Wi-Fi connectivity LED


	Product and Safety Specifications
	Features and Specifications
	Print performance
	Photo printing features
	Copy document features
	Copy photo features
	Scanning features
	Faxing features and specifications
	Paper input tray
	Automatic Document Feeder (ADF) for originals
	Ink cartridges
	Connectivity
	Software support
	Physical specifications
	Warranty
	Minimum System requirements
	Computer with WINDOWS OS
	Computer with MAC OS
	Paper types supported
	Paper sizes supported


	Safety information
	Regulatory compliance
	FCC statement
	Canadian statements
	European compliance statement
	German compliance statement
	REACH Article 33 declarations
	Power supply information
	Waste electrical and electronic equipment labeling

	ENERGY STAR® Qualified
	Warranty Information
	Declaration of Conformity


